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Introduction

Purpose of this manual

This manual explains how to use the XDCAM EX Clip 
Browsing Software on Microsoft Windows. This manual 
is intended for users who will use this application to 
perform file and folder operations. It assumes that readers 
have a basic familiarity with Microsoft Windows.

Notes on use of XDCAM devices

• This software cannot access an XDCAM HD device 
while another XDCAM-compatible application (PDZ-1) 
is accessing that device.

• While running this software, if it becomes necessary to 
connect/disconnect the i.LINK cable or power on/off the 
XDCAM device, always do such operations after you 
exit this software.

Overview

The XDCAM EX Clip Browsing Software allows you to 
work with clips created with XDCAM EX/XDCAM HD 
devices.
After installing this application on your computer, you can 
use its intuitive graphical user interface to organize your 
clips by copying, moving, and deleting them. You can also 
perform format conversions, preview the clips, and view 
their metadata.
This software supports the following clip formats.

a) Referred to in this manual as “DV-AVI clips” or “DV-AVI files”.
b) Some functions are not supported.

Media (such as SxS memory cards) that contains HQ 1440 
clips or DV-AVI clips is not recognized as usable media by 
the PMW-EX1/EX3/EX30.

New functions supported in Version 
2.6

The following table shows the principal new functions 
supported in Version 2.6.

Clip File format Extension

XDCAM EX format 
compatible clips

MP4 mp4

DV-AVI Type2 a), b) avi

XDCAM HD format clips MXF b) mxf

Note

Function Description Reference

DV-AVI clip 
operations

Preview and other 
operations are 
supported for DV-AVI 
clips. However, some 
operations are not 
available.

–

Export of clip lists You can export lists of 
the clips on media and 
in folders. The lists are 
exported as XML files 
and style sheets, and 
they can be viewed and 
printed in Windows 
Internet Explorer.

Page 17

Display of 
acquisition 
metadata

You can display the 
acquisition metadata of 
MP4 clips for each 
frame as an animation 
or in text format.

Page 21
7Introduction / Overview
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Hardware and software 
requirements

Install this application on a computer meeting the 
following hardware and software requirements.

a) Microsoft, Windows, Windows Vista, and Windows 7 are registered 
trademarks of Microsoft Corporation in the United States and other 
countries.

b) Intel, Intel Core and Pentium are trademarks or registered trademarks of 
Intel Corporation or its subsidiaries in the United States and other 
countries.

c) To use keyword searching on Windows XP, the latest version (Version 
3.00 or higher) of Windows Desktop Search (WDS) must be installed. 
Keyword searching is not available if WDS is not installed or if the 
installed version is not the latest version.
The WDS component is preinstalled on Windows Vista and Windows 7. 
It does not need to be installed again.

d) When viewing or printing exported clip information

All product names and brand names are registered 
trademarks or trademarks of their respective owners.

XDCAM devices supported by the 
application

This application supports the following XDCAM devices:

The mixed format recording mode of the XDCAM HD422 
series is not supported. When an XDCAM device is in 
mixed format recording mode, it may not be possible to 
specify the device as the destination of a copy or move 
operation.

Batch editing of clip 
properties

You can perform batch 
editing of the properties 
(Status, Title 1, Title 2, 
Creator, and 
Description) of MP4 
and MXF files.

Page 22

Flash band 
correction

You can correct frames 
that display the flash 
banding that 
sometimes occurs in 
MP4 and DV-AVI files.

Page 33

Item Description

OS Microsoft Windows XP SP3 or higher (32-bit 
version), Microsoft Windows Vista SP1 or 
higher (32-bit version or 64-bit version), or 
Microsoft Windows 7 (32-bit version or 64-bit 
version) a)

CPU Intel Pentium 4 2.0 GHz or higher (Intel Core 2 
Duo Processor 2.0 GHz or higher 
recommended) b)

Memory 1 GB or more (2 GB or more recommended)

Display Resolution: 1280 x 1024 pixels or better

Audio Audio playback function

Other • Windows Desktop Search (WDS) c)

• Windows Internet Explorer 7 or higher d)

Function Description Reference

Series name Model name

XDCAM HD422 (Version 1.2 or higher) PDW-F800

PDW-700

PDW-F1600

PDW-HD1500

PDW-HR1

XDCAM HD (Version 1.92 or higher) PDW-F355L

PDW-F335L

PDW-F335K

PDW-F75

XDCAM HD Drive PDW-U1

Note
Overview
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Installing the Application

If the MainConcept plug-in software is installed
If you have purchased the plug-in software, access the 
following URL and update it to the latest version. You can 
access this website by selecting [MainConcept Version...] 
from the [Help] menu, and then clicking the URL in the 
dialog that appears.
http://www.mainconcept.com/plugin4clipbrowser

If Version 1.0x is installed
Uninstall Version 1.0x (1.00 or 1.01) (see page 9) before 
you start the installer.

Installing from the CD-ROM

1 Insert the supplied CD-ROM into the CD-ROM drive 
of your computer.

The cover page appears automatically in your browser. 
If it does not appear, double click index.htm on the 
CD-ROM.

2 Select and click [Windows XP/Vista/7] from the 
XDCAM EX Clip Browsing Software Installer. 

The folder where the setup application is stored 
appears.

3 Double click Setup.exe.

The setup wizard appears.

4 Click the [Next] button in the setup wizard.

A license agreement screen appears.

5 Click the [Accept] button, and then click the [Next] 
button.

The following screen appears.

6 Change the settings as required, and then click the  
[Next] button.

To change the installation destination
Click the [Browse...] button and select the folder in the 
dialog that appears.

Complete the installation by following the instructions 
on the screen.
The following screen appears when the installation 
finishes.

7 Click the [Finish] button to close the dialog.

To uninstall the application
Select Add or Remove Programs in the Windows Control 
Panel, and then select and delete [XDCAM EX Clip 
Browser] from the list of installed programs.

Uninstalling the application also uninstalls the 
MainConcept plug-in software at the same time.

Note
9Installing the Application
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Launching and Exiting 
the Application

See “Installing the Application” (page 9) for more 
information about how to install the application.

Launching the application

Double click the shortcut icon on the desktop.
The XDCAM EX banner appears, the application starts, 
and the operating windows (see page 11) appear.

It is not possible to launch more than one instance of this 
application at one time.

Exiting the application

Do one of the following.
• Select [Exit] from the [File] menu.
• Click the x button in the upper right of the operating 

window.

Do not power off the computer while a file operation is still 
underway. Files may be corrupted. Wait until the operation 
finishes, or cancel the operation, before powering off.

Note

Note
Launching and Exiting the Application
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Names and Functions of Parts

Operating window configuration

The following figure shows the default configuration of 
the operating windows.

a Main window
This is the main window of the application. It contains 
Explorer windows and Preview windows.
The title bar displays the name of this application, 
followed by the title of the active window inside the main 
window frame (Explorer or Preview).
The menu and menu items in the menu bar change 
depending on the window inside the main window frame 
(or the active window, when more than one window is 
open).

b Explorer windows
You can have up to ten Explorer windows open at one 
time. When you have more than one window open, you can 
convert them into tabs on one window.

For details, see “Explorer window” (page 13).

1 Main window

2 Explorer windows 3 Preview window

Name of this application

Title of the active window

Menu bar
11Names and Functions of Parts
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c Preview windows
You can have up to five Preview windows open at one 
time. When you have more than one window open, you can 
convert them into tabs on one window.

For details, see “Preview window” (page 17).

To customize the window configuration

To open another window
Select [New Explorer Window] or [New Preview 
Window] from the [Window] menu. A new Explorer or 
Preview window opens.

To tab windows
You can convert windows of the same type (Explorer or 
Preview) into tabs in a single window.
To tab a window, drag it and drop it on another window.

When one Preview window is already open, you can open 
a new Preview tab by doing one of the following in an 
Explorer window.
• Double click a media file in the List View pane.
• Select a media file in the List View pane, and then select 

[Play] from the [Clip] menu.

If the selected media file is already loaded into its own 
Preview window or a Preview tab, that window or tab is 
activated.

To convert a tabbed window back into a separate 
window
Drag the tab of the window that you want to separate away 
from the other window.

Other window operations
• Drag the window title bar to move a window.
• Resize a window by dragging on any window border.
• Click a maximize button in the upper right corner of a 

window to maximize it.
• Close a window you do not need by clicking the x (close) 

button in the upper right corner.

The application remembers your most recent configuration 
and recreates it the next time it starts.

To optimize the window configuration
Select [Optimize Window Layout] from the [Window] 
menu. This optimizes the positions of Explorer and 
Preview windows in the main window.

When the snap function is enabled
When you resize a window by dragging its border, 
neighboring windows are also resized while preserving the 
window layout.

You can disable the snap function. For details, see “User 
settings” (page 40).

You can operate with the Shift key pressed to temporarily 
reverse the snap function setting.
When the snap function is enabled: The function is 

temporarily disabled.
When the snap function is disabled: The function is 

temporarily enabled.

Tabbed windows

Tip
Names and Functions of Parts
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Keyboard shortcuts for selecting windows 
and tabs
You can use keyboard shortcuts to select windows and 
tabs.

To select the next window from the keyboard
Hold down the Ctrl key and press the Tab key. (This 
manual refers to this operation as “press Ctrl + Tab”.)
The next window is selected with each key press.
You can select the next window in reverse order by 
pressing Ctrl + Shift + Tab.

To select the previous or next tab from the 
keyboard
Press Ctrl + PageUp, or Ctrl + PageDown.

Explorer window

Explorer windows are where you operate on clips (files) 
and folders, and where you check clip metadata. You can 
operate on XDCAM EX/XDCAM HD format folders and 
media.

a Tab
The tab displays the name of the media or folder that is 
selected in the Tree View pane.
When two or more Explorer windows are open, you can 
drag and drop the tab on another window to convert this 
window into a tab on the other window (see page 12).

b Path
This is the full path to the media or folder that is selected 
in the Tree View pane.

c Toolbar
Contains tool buttons for operations on clips and folders.

1 Tab

2 Path

3 Toolbar

4 Tree View pane

5 Capacity

7 Information about selected clips

9 List View pane

8Component View pane

6 Folder type

Tool buttons Function Reference

Icon Name

 

New Folder Creates a new 
folder in the 
currently selected 
media or folder.

Page 35

 

Find Opens the Find 
dialog.

Page 32

 

Copy All Copies all of the 
clips in the selected 
media or folder to a 
new folder. This 
application creates 
the new folder 
automatically.

Page 24

 

Cut Cut the selected 
clip.

Page 25

 

Copy Copy the selected 
clip.

Page 23

 

Paste Pastes a clip that 
has been cut or 
copied to another 
media or folder.

Page 23
Page 25

 

Delete Delete the selected 
clip or folder.

Page 26
Page 36

 

Eject Media When an XDCAM 
drive or SxS 
memory card drive 
is selected in the 
Tree View pane, 
ejects the media or 
puts it into a state in 
which it can be 
safely removed (see 
“About the Eject 
Media button” 
below).

–

 

Folder Tree 
Display/
Hide

Shows or hides the 
Tree View pane.

–

 

Show/Hide 
Component 
View

Shows or hides the 
Component View.

–

 

View Filter Filters the display of 
XDCAM EX clips by 
file format (showing 
all clips, MP4 clips, 
or DV-AVI clips).

–

13Names and Functions of Parts
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About the Eject Media button
The operations that are executed or enabled when you 
click this button vary depending on the target drive.

a) Before removing a connection cable or powering a device off, use the 
[Safely Remove Hardware] function of the operating system to remove the 
device.

d Tree View pane
Displays a tree of media and folders located beneath My 
Computer.
The following icons represent the type of the media or 
folder.

The Tree View pane supports the same kinds of operations 
as the tree panel of Windows Explorer.

You can show or hide folder contents by clicking the 
Folder Tree Display/Hide button on the toolbar.

• When you select a media item, a message may appear 
saying that salvage is required, and that you should 
salvage the media on the device that recorded it. This 
message appears when the data is defective, typically 
because the XDCAM EX device was powered off or the 
media was ejected too soon during recording. If this 
message appears, you should reinsert the media into the 
XDCAM EX device and attempt to salvage it as soon as 
possible. The data may become unrecoverable if you 
continue to work with it without salvaging it.

• Depending on the Windows desktop theme, some 
characters may fail to appear in list view. But this has no 
effect on operations by this application.

e Capacity
Displays the used capacity and remaining capacity of the 
media selected in the Tree View pane.
The remaining capacity is shown as a numeric value and as 
a bar graph. The orange bar grows longer as more of the 
media’s capacity is used.

f Folder type
Displays the type of the folder being selected in the Tree 
View pane.
EX: Folder with EX attributes
MXF: Folder with MXF attributes

g Information about selected clips
Displays information about the clips that are selected in the 
List View pane (number of selected clips, total clip length, 
and total size).

The total clip length is an approximate value, so take it as 
an approximate guide.

h Component View pane
Displays the component files of a clip in temporal order.
To display this pane, select [Component View] from the 
[View] menu, or click the Show/Hide Component View 
button in the toolbar.
When a single DV-AVI file is selected in the List View 
pane, this pane displays thumbnails of the clip’s 
component files.

• This pane displays the component files of DV-AVI clips 
only.

• Copy, delete, and other file operations are not supported 
in the Component View pane.

 

List View Switches the clip 
view mode 
(thumbnails/list/
details).

–

Drive (media) Executed or enabled operation

XDCAM EX device 
(SxS memory card)

The USB connection is terminated. 
You can remove the USB cable or 
power the device off.

ExpressCard slot 
(SxS memory card)

The connection is terminated. You 
can remove the memory card.

Card reader (SxS 
memory card)

You can remove the memory card. a)

XDCAM device 
(Professional Disc)

The disc is ejected. a)

Icon Type of media or folder

Hard disk drive

CD, DVD or Blu-ray Disc drive

XDCAM drive (normal)

XDCAM drive (UserData)

SxS memory card drive

Mass storage device (removable drive) 
connected by USB

Mounted network drive

Normal folder, not managed by this application

Folder with EX attributes

Folder with MXF attributes

Tool buttons Function Reference

Icon Name

Notes

Note

Notes
Names and Functions of Parts
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i List View pane
Displays the clips in the media or folder that is selected in 
the Tree View pane. You can select from the following 
three view modes.
Thumbnail View: This view displays the index picture of 

each clip (or a thumbnail of the first frame) and two 
properties (by default, the clip name and the date and 
time when the clip was shot).

You can select different clip properties to display. For 
details, see “User settings” (page 40).

List View: This view displays an icon indicating the type 
and current state of the clip, and the name of the clip.

Details View: This view displays an icon indicating the 
type and current state of the clip, the name of the clip, 
and its properties.

To switch the clip view mode
Do one of the following.
• Select [Thumbnails], [List], or [Details] from the [View] 

menu.
• Click the List View button in the toolbar, and then select 

[Thumbnails], [List], or [Details].

A mark for the clip status is displayed on the thumbnail or 
icon in all of the view modes.

View mode Icon Description

List or 
Details view

Normal MP4 file

MP4 file with OK status a)

An MP4 file in which some of the 
video cannot be displayed. 
However, the video that can be 
displayed is handled like a normal 
MP4 file, and clip operations are 
supported.

Abnormal MP4 file (without data, 
cannot be decoded, etc.)

Normal DV-AVI file

A DV-AVI file in which some of the 
video cannot be displayed. 
However, the video that can be 
displayed is handled like a normal 
DV-AVI file, and clip operations are 
supported.

Abnormal DV-AVI file (without 
data, cannot be decoded, etc.)

Normal MXF file

MXF file with OK status (as set on 
the XDCAM device) a)

An MXF file in which some of the 
video cannot be displayed.
However, the video that can be 
displayed is handled like a normal 
MXF file, and clip operations are 
supported.

Abnormal MXF file (without data, 
cannot be decoded, etc.)
15Names and Functions of Parts
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a) Clips with OK status can be moved or deleted by this application.
b) When a clip spans several media discs or memory devices, parts on other 

discs or memory devices are not played back.
c) A clip that cannot be played or displayed properly by this application. The 

file may be corrupt or thumbnail creation may have failed.
d) A clip that cannot be played or displayed properly by this application. 

Another application is using the clip file.

To sort the Details View list
Click the header of the column that you want to use as the 
sort key.
Each click sorts the list again in ascending or descending 
order.
You can also sort by selecting one of the following items 
under [Sort By] in the [View] menu.
• Clip Name
• Size
• Duration
• Status
• Creation Date

• Last Update
• Recording Mode
• Media Spanning

To select the items to display in Details View
Open the dialog shown below by selecting [Customize 
Columns...] from the [View] menu, and then proceed as 
follows.

To select an item to display: Check the check box. You 
can click the [Show All] button to check all of the 
check boxes.

To select an item to hide: Clear the check box. You can 
click the [Hide All] button to clear all of the check 
boxes except “Clip Name”.

To change the display order: Click an item to highlight 
it, and click the [Up] or [Down] button.

To return to the default settings: Click the [Reset to 
Default] button.

To confirm the changes: Click the [OK] button. 
To cancel the changes: Click the [Cancel] button.

To select the items to display in tooltips
You can select the items that appear in tooltips when the 
pointer is moved over a clip in the List View pane. Select 
[Customize Tooltip...] from the [View] menu to open the 
dialog shown below, and select the items that you want to 
display.

See the previous section “To select the items to display in 
Details View” for operations in the dialog.

View mode Thumbnail display 
example

Description

Thumbnails 
view

Normal clip

Clip with OK status a)

The first part of a clip 
that spans several 
media discs or 
memory devices. b)

The middle part of a 
clip that spans several 
media discs or 
memory devices. b)

The last part of a clip 
that spans several 
media discs or 
memory devices. b)

A clip in which some 
of the video cannot be 
displayed. However, 
the video that can be 
displayed is handled 
like a normal clip, and 
clip operations are 
supported.

A clip that cannot be 
loaded. The clip 
cannot be previewed, 
and its properties 
cannot be edited. c), d)
Names and Functions of Parts
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To export a list of clips
You can export a list of the clips in a selected media or 
folder. The list is exported as two files (an XML file and a 
style sheet) and can be viewed and printed in Windows 
Internet Explorer. 1)

1) This function has been tested on Windows Internet Explorer 7 and 
Windows Internet Explorer 8.

1 In the Tree View pane of an Explorer window, select 
the media or folder that you want to use as the data 
source for the clip list.

2 In the List View pane, select the clips to include in the 
clip list. (You can skip this step if you want to output 
all clips, or all clips in the format selected by the 
current display filter.)

3 From the [File] menu, select [Output...].

The Output dialog opens.

4 Set the following items.

Output Destination
• Folder: Specifies the output folder. Enter a path 

beginning with a drive name in the edit box. Or click 
the [...] button to open a browse dialog where you 
can select a folder, and then click the [OK] button.

• Data Name: A new folder with this name is created 
in the output folder, and output files with this name 
(an XML file and a style sheet) are output to the new 
folder.

Due to browser limitations, it may not be possible to 
view clip lists properly when some characters are used 
in clip file names. We recommend that you use ASCII 
characters and numbers only in file names.

Output Option
• Thumbnails: Output clip thumbnails (JPEG files) in 

addition to text data.
• Detailed Essence Marks: Output detailed 

information about the essence marks in the clips.

Output Range
• All: All clips in the selected media or folder
• Displayed Clips (MP4/DV-AVI): Clips displayed in 

the List View pane
• Selected Clips: Clips selected in the List View pane

5 Click the [Execute] button to start the export.

A progress bar appears to show the progress of the 
export. The following dialog appears when the export 
finishes.

To display the XML file immediately after finishing 
this procedure
Check the [Display the output file.] check box.

6 Click the [OK] button to close the dialog.

To open the output files
In the folder named after the specified data name, double 
click either the .xml file or the .xsl file (both of which have 
the same name as the folder).
The file list appears in Windows Internet Explorer, where 
you can view it or print it.

Preview window

Preview windows are where you preview clips and check 
clip information.

Notes about the Preview window
Playback in this window is preview playback. Note the 
following points.
• Depending on the performance of your computer and the 

processing load, dropped frames may occur,  timecode 
may differ from the actual values, the clip may not be 
played smoothly, and some time may be required before 
the screen is updated.

• When the playback clip is defective, video breakup may 
occur and the playback may freeze.

• Not all of the original recorded video is played back 
when a split clip is played back.

• It may not be possible to play clips created on devices 
other than XDCAM EX devices.

• Improper playback may occur if the screen properties of 
your computer are changed during playback. If this 
occurs, restart the application.

Note
17Names and Functions of Parts
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a Tab
Displays the clip name.
When two or more Preview windows are open, you can 
drag and drop the tab on another window to convert this 
window into a tab on the other window (see page 12).

b Clip name
Displays the clip name of the selected tab.

c Viewer
Previews clips (see next section).

d Splitter
You can drag the splitter up and down to change the 
relative sizes of the viewer and the clip properties section.

e Clip properties section
Allows you to check clip properties (see page 20).

Viewer

a Screen
Displays the playback video.
You can double click the screen or select [Full Screen] 
from the [View] menu to enlarge the size to full screen 
size.
To return to the original size, double click the screen again 
or press the Esc key.

b Clip type
Displays the type of the clip being viewed on the viewer.
XDCAM EX (MP4): XDCAM EX clip (MP4 file)
XDCAM EX (DV-AVI): XDCAM EX clip (DV-AVI 

file)
XDCAM HD/HD422: MPEG HD file created from 

XDCAM HD or XDCAM HD422 clip (MXF file)
XDCAM HD/HD422 Proxy: Proxy file created from 

XDCAM HD or XDCAM HD422 clip (MXF file)

c Number of essence marks
Displays the number of the essence marks set in the clip (in 
the format of: actually set number/maximum allowable 
number).

d Timecode
Displays the timecode of the current position (playline 
position), and the duration of the section between In and 
Out points in the clip. A counter value is displayed when 
no timecode is recorded in the clip.
For NTSC clips, a period (.) between the minutes and 
seconds of the current position indicates drop-frame, and a 
colon (:) indicates non-drop-frame.

1 Tab

2 Clip name

3 Viewer

5 Splitter

5 Clip properties section

4 Timecode

5 Position bar

6 Playline

7 Command buttons

1 Screen

3 Number of essence marks

2 Clip type
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It is possible to jump to a specified position by clicking the 
current position timecode, entering a numeric value, and 
pressing the Enter key. (This operation is ignored when 
invalid timecode is entered.)

You can change the timecode display format. For details, 
see “User settings” (page 40).

e Position bar
Displays the time scale of the clip.
The following marks are shown on the position bar to 
provide information about the clip.

a) The display of flash band correction marks takes priority over display of 
essence mark marks.

f Playline
Displays the current position on the time scale.
You can drag the playline or click anywhere on the 
position bar to move to a desired position. Scrubbing 
(repeatedly dragging to the left and right) is also supported.

g Command buttons
These buttons perform various clip preview operations.
The functions of these buttons can also be accessed from 
the keyboard.

Mark Meaning

In point

Out point

Essence mark a)

Timecode break point (discontinuous 
timecode)

Split point between component files (appears 
only when a DV-AVI file consists of several 
component files)

Flash band correction has not been applied a)

Flash band correction has been applied a)

Icon Button 
name

Keyboard 
operation

Function

Jump to 
Start

Home Jumps to the clip 
start point (first 
frame).

Jump to 
End

End Jumps to the clip 
end point (last 
frame).

Mark In a) I Sets an In point at 
the current 
position. Can be 
done during play 
(play continues).

Play In to 
Out

Shift + 
Space

Plays the section 
from the In point 
to the Out point. 
(During play, the 
button icon lights 
green.) Stops play 
if clicked during 
play.

Mark Out a) O Sets an Out point 
at the current 
position. Can be 
done during play 
(play continues).

Clear Mark 
In/Out a)

Shift + X Clears In and Out 
point settings. 
Can be done 
during play (play 
continues).

Jump to In 
point

R Jumps to the In 
point.

Jump to 
Out point

r Jumps to the Out 
point.

Play Space Plays the clip. 
(During play, the 
button icon lights 
green.) Stops play 
if clicked during 
play.

Add 
Essence 
Mark a)

E Adds an essence 
mark at the 
current position. b) 
Can be done 
during play (play 
continues). 
However, an 
essence mark 
cannot be set at a 
position where 
one already 
exists.

Delete 
Essence 
Mark a)

Shift + E Deletes the 
essence mark at 
the current 
position. Can be 
done during play 
(play continues).

Set Index 
Picture c)

P Sets the current 
frame as the 
index picture of 
the clip. Can be 
done during play 
(play stops).

Icon Button 
name

Keyboard 
operation

Function
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a) Editing of edit points (In and Out points) and essence marks is not 
supported for the following clip types.
• Clips on XDCAM drives
• DV-AVI clips

b) The maximum number of essence marks that you can set in a single clip is 
as follows, depending on the clip format.
• XDCAM EX clip (MP4 file): 126 
• XDCAM HD clip (less than 126 seconds): the number of seconds + 1 

(for example, 46 marks for a 45-second clip)
• XDCAM HD clip (126 seconds or more): 126

c) Index pictures cannot be set for DV-AVI clips.

Clip properties section

General tab

This tab displays general information about the clip.
• Index Picture: Displays the index picture of the clip, or a 

thumbnail of the first frame if no index picture has been 
set.

• Mark In: Displays a thumbnail of the In point, or a 
thumbnail of the first frame if no In point has been set.

• Mark Out: Displays a thumbnail of the Out point, or a 
thumbnail of the last frame if no Out point has been set.

• Clip Name
• Creation Date (date and time of creation)
• Last Update (date and time of most recent update)
• Duration (clip length)
• Status: Displays the clip status. You can select the status 

from among OK, NG, KEEP, and None.
• Title 1: Allows you to assign a title up to 63 ASCII bytes 

in length.

• Title 2: Allows you to assign a subtitle up to 127 bytes in 
length.

• Creator: Allows you to enter the name of the person who 
shot the clip, up to 127 bytes in length.

• Description: Allows you to enter a description of the 
scene depicted in the clip, up to 2047 bytes in length.

To save changes to the Status, Title 1, Title 2, Creator, and 
Description fields, you must click the [Update] button. The 
changes are discarded if you close the window or tab 
without clicking the [Update] button.

You can batch edit these properties if you wish to share 
them among all clips in a folder or on a media device. For 
details, see “To perform batch editing of clip properties” 
(page 22).

The properties of DV-AVI clips cannot be edited.

A/V Format tab

This tab displays information about the recording format 
of the clip.
• Video Format 
• Audio Format

Related Info tab

This tab displays information related to clip recording 
conditions.
• Model
• Lens Model
• Recording Mode
• Media Spanning
• File Name
• Number of Files

Set Audio 
Channels

– Opens the Set 
Audio Channels 
dialog.

Capture 
Still Image

– Saves the frame 
at the current 
position as a 
bitmap file. This 
command opens 
a dialog where 
you can specify 
the file name and 
save destination. 
However, still 
images cannot be 
created from a 
clip on XDCAM 
disc.

Icon Button 
name

Keyboard 
operation

Function
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• UMID
• Key Frame
• User Bit
• Proxy AV Data
• Edit List
• Hard- & Software

Essence Mark tab

This tab displays a list of essence marks in the current clip, 
with the timecode of the essence marks and the associated 
comments.
You can select an essence mark in this list to move the 
playback position to that frame.

To edit a comment: Select an essence mark in the list and 
click the [Edit] button. This opens the Edit Comments 
dialog. Edit the comment in the dialog and click the 
[OK] button. The maximum length of comments is 32 
bytes. The edited comment appears in the Comment 
field.

To delete an essence mark: Select an essence mark in the 
list (you can select multiple essence marks by clicking 
with the Ctrl or Shift key held down), press the 
[Delete] button, and click [Yes] in the confirmation 
dialog that appears.

• Editing of essence mark comments is not supported for 
clips of the following types.
- Clips on XDCAM drives
- DV-AVI clips

• The only essence marks that can be displayed on 
XDCAM EX devices are “_ShotMark1” and 
“_ShotMark2”.

• During playback on XDCAM EX devices, essence 
marks set by this application are displayed next to the 
frames where they were set.

Acquisition tab: Animation View

Acquisition tab: Text View

You can display acquisition metadata for clips shot in the 
MP4 format. This data provides information about the 
conditions under which the clip was shot. By selecting 
from the list box at the top of the tab, you can switch 
between [Animation View] and [Text View].
• Model Name: Camera/Lens
• Video Format
• Date and Time
• Auto Mode: AE/AF/WB (auto exposure/auto focus/

white balance)
• Lens Setting: Macro/Opt.Extender (macro/optical 

extender)
• Lens Parameter: Iris/Focus/Zoom/Angle of View/

Focusing
• Filter Wheel: ND/CC (ND filter/CC filter)
• Capturing: Mode/Rate/Shutter (shooting mode/frame 

rate in Slow & Quick Motion shooting/shutter speed)
• Processing: Gain/Elec.Extender/White Balance/Black/

Gamma (gain/digital extender/white balance/black 
level/gamma)

• The Acquisition tab does not appear when the target clip 
is in the DV-AVI or MXF format.

• Acquisition metadata cannot be displayed for import 
material, material containing recorded line input signals, 
and so on.

Notes Notes
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Flash Band tab

This tab displays information about frames where flash 
banding has occurred. This tab appears only for MP4 and 
DV-AVI clips that allow flash band detection and 
correction.
• Timecode: Timecode of the frame where flash banding 

was detected (or timecode of a frame added by the user)
• Field: In the case of interlaced video, the field where 

correction starts (1st/2nd)
• Detect: The detection method (Auto/Manual)
• Status: Correction status (empty field, indicating not yet 

corrected/Corrected)

See “Correcting flash bands” (page 33) for information 
about operations.

To perform batch editing of clip properties
You can perform batch editing of the properties (Status, 
Title 1, Title 2, Creator, and Description) of clips in the 
selected folder or on the selected media.

The properties of DV-AVI clips cannot be edited.

1 In the Tree View pane of an Explorer window, select a 
media device or a folder.

2 In the List View pane, select the batch editing target 
clips. (You can skip this step if you want to edit all 
clips, or all clips in the format selected by the current 
display filter.)

3 From the [Edit] menu, select [Batch Edit Clip 
Properties...].

The Batch Edit Clip Properties dialog opens.

4 Select the edit range.

• All: All clips in the selected media or folder
• Displayed Clips (MP4): Clips displayed in the List 

View pane
• Selected Clips: Clips selected in the List View pane

5 Check the check box for each batch edit item that you 
want to change, and then select a value from the list 
box or enter a string in the edit box.

• Status: Select from among OK, NG, KEEP, and 
None.

• Title 1: Up to 63 ASCII bytes in length
• Title 2: Up to 127 bytes in length
• Creator: Up to 127 bytes in length
• Description: Up to 127 bytes in length

To overwrite existing settings
Check the [Overwrite the edited item] check box.
If this check box is cleared when the batch edit is 
executed, the changes made here are reflected only to 
empty fields.

6 Click the [Execute] button.

A confirmation message appears, asking if you want to 
execute the batch edit.

7 Click the [Yes] button to execute the batch edit, or 
click the [No] button to cancel it.

A progress bar appears to show the progress of the 
batch edit. A completion dialog appears when the 
processing finishes.

8 Click the [OK] button to close the dialog.

Note
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Clip Operations

Clip operation precautions
• Always observe the following precautions during 

processing of clip operations.
- Do not power off the computer or media drive before 

the operation completes.
- Do not use Windows Explorer or another file 

management tool to delete folders that contain the 
clips being processed.

- Do not eject the media before the operation completes.
• It may be possible to copy and move clips to media with 

this application even when the display on an XDCAM 
EX device indicates that the media is full. However, it 
will not be possible to play back or delete those clips 
when the media is inserted into the XDCAM EX device 
again (a message will appear saying that the media must 
be salvaged).

• For the folders created on a hard disk or other media by 
copying from XDCAM drive with Windows Explorer or 
other folder management tool, editing operations such as 
adding and deleting of clips cannot be performed.

• If the NAMING FORM menu item of an XDCAM HD 
device is set to “C**** (standard format)”, any user-
defined file names (names in a format other than C****) 
are changed automatically to the standard format 
(C****) when the clips are written to the XDCAM drive.

• Writing a 50p or 60p frame rate clip to XDCAM drive 
moves the essence marks and Out points at the odd 
frames to the previous or next even frames. For example, 
the essence mark at the 15th frame moves to the 14th, 
while the Out point at the 19th frame moves to the 20th. 
However, the Out point will be deleted if an essence 
mark already set at the move destination frame.

For details about the menu operations of the XDCAM HD 
device, refer to the Operating Instructions or Operation 
Manual supplied with the XDCAM HD device.

Copying clips

You can duplicate clips on your media or computer, and 
copy clips between media and the computer.

When copying MXF clips to XDCAM drive or a folder 
with MXF attributes, it is not possible to copy the clip of a 
different recording format from that of the clips in the 
destination. 

Grouping split clips by gathering them into one 
place
XDCAM EX devices automatically save video that 
exceeds 4 GB in size as multiple clips. If you collect these 
clips into one media or folder, they are automatically 
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate 
media” (page 26) for more information.

To copy selected clips

1 Select a clip to copy in the List View pane of an 
Explorer window.

• Abnormal clips can be selected, but they are not 
copied.

• The folder that contains the selected clips cannot be 
specified as the copy destination.

If you want to copy the clips to a new folder
Create a new folder in the copy destination media or 
folder.

See “Creating folders” (page 35) for more 
information about how to create folders.

2 Do one of the following.

• Drag the clips selected in step 1 and drop them in the 
List View pane of another window, or on a copy 
destination media or folder in the Tree View pane of 
the same window or another window.

• Click the Copy button. Then click the List View 
pane of another window, or a copy destination media 
or folder in the Tree View pane of the same window 
or another window, and click the Paste button of that 
window.

• Select [Copy] from the [Edit] menu. Then click the 
List View pane of another window, or a copy 
destination media or folder in the Tree View pane of 
the same window or another window, and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the 
copy.

Note
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3 Click the [Yes] button to execute the copy, or the [No] 
button to cancel it.

A dialog illustrating the progress of the copying opens 
when the copying starts.

Once it has been completed, you cannot undo the copy 
operation.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In 
these cases, an error message appears and the copy is 
not executed.
• There is not enough free capacity at the copy 

destination.
• A clip with the same name as one of the selected 

clips already exists at the copy destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the 
destination media or folders.

• The destination media or folder is write protected.

If you copy an XDCAM EX file to a copy 
destination with MXF attributes
Copying an XDCAM EX MP4 file to an XDCAM drive or 
an MXF folder automatically converts the file to the 
XDCAM HD format (MXF file). This makes EX material 
available on your XDCAM HD device more easily than 
the export function (see page 28).
Copied files have the same recording format as that of the 
existing files in the destination.1) However, the bit rates are 
determined as specified in [Bit Rate] under [MP4 to MXF 
conversion by copy] in the Conversion tab of the User 
Configuration dialog (see page 42).

1) If no file exists in the destination, the bit rate is determined as specified in 
[Format settings for empty destination folders] under [MP4 to MXF 
conversion by copy] in the Conversion tab of the User Configuration 
dialog.

When the [Convert in MXF for copying EX to a normal 
folder] check box in the Edit tab of the User Configuration 
dialog (see page 40) is checked, even the files which are to 
be copied to a normal folder are converted to the MXF 
format. Since the clip management folders for the 
XDCAM HD device (see page 40) are automatically 
created, the files converted in this application can be 
viewed. (The files which were output to a normal folder by 
the export function cannot be viewed in this application.)

• DV-AVI format EX files cannot be converted into 
XDCAM HD format files.

• It is not possible to convert XDCAM HD files to the 
XDCAM EX format.

• File conversion may not be possible, depending on the 
combination of source format and target format.

• Unless the licensed plug-in from MainConcept is 
installed, the video after conversion contains a 
MainConcept watermark, and audio is silent after the 
first 30 seconds.

• File conversion may degrade the image quality.
• This copy operation takes longer to complete since it 

requires format conversion.
• The MXF files produced by converting XDCAM EX 

MP4 files to XDCAM HD format are MPEG HD files 
only. The conversion does not produce Proxy files.

To copy all the clips in media or folders
You can copy all of the clips in a folder or a media disc or 
card in a single operation. This is a convenient way to 
import all the clips in an SxS memory card to the hard disk 
of your computer.

1 In the Tree View pane of an Explorer window, select 
the media or folder that contains the clips you want to 
copy.

2 Do one of the following.

• Click the Copy All button.
• Select [Copy All] from the [Edit] menu.

A message appears asking if you want to execute the 
copy. Check the destination folder.

You can change the copy destination folder. See “User 
settings” (page 40) for more information.

3 Click the [Yes] button to execute the copy, or the [No] 
button to cancel it.

A dialog illustrating the progress of the copying opens 
when the copying starts.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In 
these cases, an error message appears and the copy is 
not executed.

Note
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• There is not enough free capacity at the copy 
destination.

• A clip with the same name as one of the selected 
clips already exists at the copy destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the 
destination media or folders.

• The destination media or folder is write protected.

Copy error check option
For greater copy reliability, you can enable the CRC 
(cyclic redundancy check) error check option. However, 
copy operations take longer to complete when this option 
is enabled.

See “User settings” (page 40) for more information about 
this option.

Moving clips

You can move clips on your media or computer, and move 
clips between media and the computer.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• Clips with OK status can be moved by this application.

Grouping split clips by gathering them into one 
place
XDCAM EX devices automatically save video that 
exceeds 4 GB in size as multiple clips. If you collect these 
clips into one media or folder, they are automatically 
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate 
media” (page 26) for more information.

Move modes
You can specify whether to give priority to processing 
speed or to data protection when moving clips.
• Processing speed: Normal move processing, without 

creating a duplicate of the clip.
• Data protection: A duplicate of the clip is created before 

the original clip is deleted.

See “User settings” (page 40) for more information about 
the settings.

1 Select a clip to move in the List View pane of an 
Explorer window.

• Abnormal clips can be selected, but they cannot be 
moved.

• The folder that contains the selected clips cannot be 
specified as the move destination.

If you want to move the clips to a new folder
Create a new folder in the move destination media or 
folder.

See “Creating folders” (page 35) for more 
information about how to create folders.

2 Do one of the following.

• Drag the clips selected in step 1, and while holding 
down the Shift key, drop them in the List View pane 
of another window, or on a move destination media 
or folder in the Tree View pane of the same window 
or another window.

• Click the Cut button. Then click the List View pane 
of another window, or a move destination media or 
folder in the Tree View pane of the same window or 
another window, and click the Paste button of that 
window.

• Select [Cut] from the [Edit] menu. Then click the 
List View pane of another window, or a move 
destination media or folder in the Tree View pane of 
the same window or another window, and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the 
move.

3 Click the [Yes] button to execute the move, or the [No] 
button to cancel it.

A dialog illustrating the progress of the move opens 
when the move starts.

• Once it has been completed, you cannot undo the 
move operation.

• Do not exit this application during the move. Doing 
so can break the links between clips and their 
metadata. The link information for split clips can be 
lost, causing them to become abnormal clips. If the 
selected clips are important, we recommend that you 
set the move mode to data protection mode (see page 
25).

Notes
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To cancel the move operation
Click the [Cancel] button in the progress dialog.

Reasons why a move operation may fail
Move operations may fail for the following reasons. In 
these cases, an error message appears and the move is 
not executed.
• There is not enough free capacity at the move 

destination.
• A clip with the same name as one of the selected 

clips already exists at the move destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the source 
or destination media or folder.

• The source or destination media or folder is write 
protected.

Deleting clips

• Clips with OK status can be deleted by this application.
• Deleting a clip linked to edit lists deletes all the edit lists 

linked to the clip.

1 In the List View pane of an Explorer window, select a 
clip to delete.

2 Do one of the following.

• Press the Delete key.
• Click the Delete button.
• Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to 
delete the clips.

3 Click the [Yes] button to execute the deletion, or the 
[No] button to cancel it.

It is not possible to undo the deletion once it has been 
completed.

Reasons why a delete operation may fail
Deletion operations may fail for the following reasons. 
In these cases, an error message appears and the 
deletion is not executed.

• You do not have delete/write privileges to media or 
folder where the clips are stored.

• The media or folder where the clips are stored is 
write protected.

Grouping clips that have been split 
across separate media

When you have split clips that have been saved on separate 
media as a result of an extended recording session, you can 
group those clips by collecting them in a single location. 
You can collect split clips by copying them, by moving 
them, or by combining split folders. Grouped clips can be 
handled as a single clip. 

See “Copying clips” (page 23), “Moving clips” (page 25), 
and “Combining folders” (page 37) for more information 
about the operations.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• Split clips which are not continuous along the time axis 
are not grouped.

• Abnormal clips are not grouped.
• Clips with altered UMIDs are not grouped. Grouping is 

performed on the basis of the UMIDs of split clips, and 
not on the basis of their file names.

Creating clips by specifying ranges

You can create a new clip by setting In and Out points in 
an existing clip. The new clip can be handled in the same 
way as the original clip. This is a convenient way to create 
clips during online editing.

This operation is limited to MP4 clips. You cannot operate 
on clips in other formats (for example, DV-AVI clips and 
XDCAM HD clips).

1 Preview a clip in a Preview window (see page 30), 
click the Mark In button at the position you want to use 
as the first frame, and click the Mark Out button at the 
position you want to use as the last frame.

In and Out points are set in the clip.

You can also set the Out point by specifying the In 
point and duration.

Notes

Note

Notes

Note

Tip
Clip Operations



  F
or W

indow
s

Duration can be specified by clicking the timecode 
display of the duration, entering a numeric value, and 
pressing the Enter key.

In and Out points cannot be set at the same frame. 
When you try to set an Out (or In) point at a frame 
where an In (or Out) point has been set, the Out point 
is automatically set at the next frame after the In point.

2 Play the section specified in step 1, and adjust the In 
point and Out point positions as required.

3 In the List View pane of an Explorer window, find the 
clip where you set the In and Out points, and click the 
clip to select it.

To create several clips in one batch operation
You can create several clips in one operation.
Carry out steps 1 and 2 in several clips stored in the 
same folder or on the same media, and then select 
those clips here.

4 From the [Clip] menu, select [New clip using In/Out 
section].

A confirmation message appears asking if you want to 
create the clips.

If the In and Out points are not set
The following message appears. If you choose to 
continue, the effect is the same as copying the 
complete original clip.

5 Click the [Yes] button to create a new clip, or the [No] 
button to cancel the operation.

A progress dialog opens when creation of the clip 
starts.

To cancel creation of the clip
Click the [Cancel] button in the progress dialog.

Reasons why a new clip operation may fail
Creation of a new clip may fail for the following 
reasons. In these cases, an error message appears and 
the clip is not created.

• There is not enough free capacity at the clip creation 
destination.

• You do not have delete/write privileges to the 
destination media or folders.

Importing clips

You can import XDCAM EX format compatible MP4 or 
DV-AVI files and register them as clips that can be 
handled by XDCAM EX devices.

This operation is limited to XDCAM EX clips. You cannot 
operate on clips in other formats (for example, XDCAM 
HD clips).

1 In the Tree View pane of an Explorer window, select 
the media or folder that contains the MP4 or DV-AVI 
files to be imported.

2 Do one of the following.

• Select [Import...] from the [File] menu.
• Right click the media or folder and select [Import...] 

from the context menu.

The Import dialog opens.

3 Select a file format from the [Files of type] list, and 
specify the MP4 or DV-AVI files to import by 
selecting them from the file list.

4 Click the [Start] button to start the import, or the 
[Cancel] button to cancel it.

A dialog illustrating the progress of the import 
operation opens when the import starts.

To cancel the import operation
Click the [Cancel] button in the progress dialog.

Note
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Reasons why an import operation may fail
File import operations may fail for the following 
reasons. In these cases, an error message appears and 
the files are not imported.
• You do not have delete/write privileges for the 

import destination media or folder.
• The import destination media or folder is write 

protected.

• This software checks import file for compatibility 
with the XDCAM EX format. Files that are found to 
be incompatible cannot be imported.

• The properties of imported clips are set 
automatically.

• The format of imported clips may not be fully 
compatible with the XDCAM EX format. In this 
case, it may not be possible to play imported clips on 
XDCAM EX devices and with this application.

• The file names of imported DV-AVI files may be 
changed to names that can be recognized by 
XDCAM EX devices.

Exporting clips

You can export files created on XDCAM EX devices for 
use in various other environments. (To export is to convert 
files into other formats and output them.)

Future versions will support additional video formats. For 
upgrade information, visit the website listed in the 
“Features” section of the Operating Instructions for your 
XDCAM EX device and on the cover page of the supplied 
CD-ROM.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• DV-AVI files are supported for “MXF for NLEs” only.

1 In the List View pane of an Explorer window, select a 
clip to export by clicking them.

2 Do one of the following.

• From the [File] menu, select [Export] and then select 
the format that you want to convert to.

• Right click the clip, from the context menu, select 
[Export] and then select the format that you want to 
convert to.

See “File conversion formats” (page 29) for more 
information about the available conversion formats.

An export dialog opens for the selected format. (The 
figure below shows the dialog that opens when you 
choose [MXF for XDCAM HD422].)

3 Change the following settings as required.

Export to: Specifies the export destination folder. 
Enter a path beginning with a drive name in the 
edit box. Or click the [...] button to open a browse 
dialog where you can select a folder, and then 
click the [OK] button.

Make sure that the export destination media has 
adequate free space before you execute the 
export. An error occurs at the point where the free 
space is used up.

Type: Click the [Details...] button to open the Codec 
Detail dialog, set parameters as required, and then 
click the [OK] button. This item does not appear 
for some conversion formats.

Depending on the number of audio channels in 
the clip, the audio output corresponds as shown 
below to the setting of the [Channel] list in the 
[Audio] section.

Notes

Notes

Note

Number 
of audio 
channels 
in clip

Setting in 
[Channel] 
list

Audio output

2 1CH Mixed signal of channels 1 
and 2
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Target of Export: Select [In/Out section] if you want 
to output the range between the In and Out points 
in the current clip. This item does not appear for 
some conversion formats.

To change the output file name
In the List View pane, do one of the following to make 
the file name changeable.
• Click the file name.
• Right click the highlighted part to display the 

context menu and select [Modify the output 
filename] from the context menu.

Enter a new name, and press the Enter key or click 
anywhere other than the file name. Extension does not 
need to be entered.

4 Click the [Execute] button to start the export.

A progress bar appears to show the progress of the 
export. The progress also appears in the [Status] 
column of the List View pane.

To cancel the export
Click the [Cancel] button.

If a file with the same name already exists at the 
output destination
A dialog appears to ask how you want to proceed.
Read the explanation in the dialog and click one of the 
buttons.

• The optional MainConcept plug-in software must be 
installed to use some conversion formats (see page 55). 
Unless the licensed plug-in from MainConcept is 
installed, the video after conversion contains a 
MainConcept watermark, and audio is silent after the 
first 30 seconds.

• Depending on the specified parameters, image quality 
may be degraded due to the image compensation 
process.

• Converted files may not be exactly the same with native 
files in the target format.

• Video metadata may not be inherited after format 
conversion.

• Image quality may be degraded if format conversion 
requires re-encoding.

• Image quality may be degraded and duration may vary if 
files are converted to a format with a different bit rate, 
resolution, or frame rate parameters.

• Before exporting, ensure that the export destination 
media or folder is write enabled.

File conversion formats
File conversion formats can be selected with the Export 
subcommands in the following table.

4 1CH Mixed signal of channels 1 
to 4

2CH Channel 1: Mixed signal 
of channels 1 and 3

Channel 2: Mixed signal 
of channels 2 and 4

Number 
of audio 
channels 
in clip

Setting in 
[Channel] 
list

Audio output Notes

Export 
subcommand

Extension 
after 
conversion

Description

MXF for NLEs a) mxf Converts to MXF file format 
without changing the bit 
rate, resolution or other 
parameters. This is for non-
linear editors that support 
MXF files only.

MXF for 
XDCAM HD b), c)

mxf Converts to an MXF format 
that is compatible with MXF 
files recorded by XDCAM 
HD devices.

MXF for XDCAM 
HD422 b)

mxf Converts to an MXF format 
that is compatible with MXF 
files recorded by XDCAM 
HD422 devices.

MXF for XDCAM 
MPEG IMX d)

mxf Converts to an MXF format 
that is compatible with MXF 
files recorded by XDCAM 
MPEG IMX devices.

MXF for XDCAM 
DVCAM d)

mxf Converts to an MXF format 
that is compatible with MXF 
files recorded by XDCAM 
DVCAM devices.

Raw DV dv Converts to RAW DV 
format.This is for DV format 
editing. Depending on the 
editing environment, use 
either this subcommand or 
the [AVI DV] subcommand.
29Clip Operations



30

  F
or W

indow
s

a) When outputting the range between the In and Out points in the current 
clip, the duration may be prolonged after conversion.

b) Clips of two seconds or less can be converted to MXF files, but they 
cannot be written to export destination devices.

c) 23.98p clips can only be converted to a format with the same frame rate 
(23.98p).

d) This application supports copying, deleting, and viewing properties of 
XDCAM MPEG IMX or XDCAM DVCAM clips. It does not support 
previewing and the other operations. Thumbnail creation fails.

e) Avid editing systems may refuse to import a clip that has already been 
exported to the editing system.

f) Improper playback may occur if the converted file is viewed on a viewer 
other than the specified devices.

Previewing clips

You can preview clips in the Preview window.

Several limitations apply to playback in the Preview 
window. For details, see “Notes about the Preview 
window” (page 17).

To load clips into the Preview window
Display the clip that you want to preview in the Clip View 
pane of an Explorer window, and then do one of the 
following.
• Double click the clip.
• Click the clip and then press the Enter key.
• Drag and drop the clip on a Preview window (this 

operation is disabled if multiple clips are selected).
• Right click the clip and select [Play] from the context 

menu.
• Click the clip and then press the space bar.

The clip is loaded into the Preview window (and playback 
starts, if you loaded the clip by selecting [Play] or pressing 
the space bar). The timecode of the current playback 
position (or a counter value) appears in the upper part of 
the screen, together with the duration of the section 
between In and Out points in the clip.

To stop play
Click the play button.

Smooth playback is not possible when previewing clips 
saved to DVD-R or CD-R discs.

To control the preview
You can use the following methods to control playback in 
the Preview window.
• Use the command buttons (see page 19) in the Preview 

window.
• Select an operation from the [Play] menu.
• Drag the playline.
• Press the J, K, or L key.

J: Change the reverse playback speed. Each press selects 
–1, –2, –4, –8, or –16 times normal speed.

K: Stop playback.
L: Change the forward playback speed. Each press 

selects 1, 2, 4, 8, or 16 times normal speed.

AVI DV avi Converts to AVI Type-2 
format.This is for DV format 
editing. Depending on the 
editing environment, use 
either this subcommand or 
the [RAW DV]  
subcommand.

Avid AAF e) AAF/mxf Converts to the following 
two file formats.
AAF file: Use to load clips 

into Avid editing 
system. The extension 
is AAF, and the output 
destination is the 
media or folder 
specified in the Export 
dialog (see page 28). 
AAF files produced by 
the conversion can be 
registered in your Avid 
editing system project 
by dragging from 
Windows Explorer to a 
bin in the project.

MXF OPAtom file: The 
extension is mxf, and 
the output destination 
is the media or folder 
specified in the 
Conversion tab of the 
User Configuration 
dialog (see page 42). 
Normally this is the 
media folder of your 
Avid editing system 
project.

For details, refer to the 
user’s manual of your 
editing system.

Windows Media 
File

wmv Converts to Windows 
Media Player 9 compatible 
format.

Sony PSP 
(H.264/AVC) f)

mp4 Converts to a format that 
allows clips to be 
previewed on the 
PlayStation Portable (PSP) 
game console from Sony 
Computer Entertainment.

Apple iPod 
(H.264/AVC) f)

mp4 Converts to a format that 
allows clips to be 
previewed on the iPod 
portable media player from 
Apple Inc.

Video hosting 
service

wmv Converts to a format 
optimized for Internet video 
hosting services.

Export 
subcommand

Extension 
after 
conversion

Description

Note
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No audio is output in playback at speeds greater than or 
equal to ±4 times normal speed.

To select full-screen playback
Double click the screen, or select [Full Screen] from the 
[View] menu.
To return to the original screen size, double click the 
screen or press the Esc key.

To change the playback mode of MXF clips
Select “MPEG HD (high resolution)” or “Proxy (low 
resolution)” in the Play tab of the User Configuration 
dialog (see page 42).
Selecting “MPEG HD” makes it possible to preview with 
high definition images when the screen size is enlarged.

• You cannot change the playback mode when a clip is 
being played.

• Clips without proxy AV data are played at a high 
resolution regardless of this setting.

• Clips on XDCAM drive are played at a low resolution 
regardless of this setting.

• High resolution data may not be played smoothly due to 
its large file size.

To select the audio channels to monitor during 
previews
In the Set Audio Channels dialog, check the L (left) or R 
(right) check box to monitor that channel.
To open the Set Audio Channels dialog, do one of the 
following.
• Select [Set Audio Channels...] from the [Play] menu.
• Click the Set Audio Channels button.

Changing the index picture of a clip

You can change index pictures during clip previews.

The index pictures of DV-AVI clips cannot be changed.

1 Play a clip, and display the frame you want to use as 
the index picture.

2 Select [Set Index Picture] from the [Edit] menu, or 
click the Set Index Picture button.

The currently displayed frame becomes the clip’s 
index picture, and the Index Picture in the General tab 
of the clip properties section changes to show it.

• If you are previewing a clip that is stored on 
removable media, do not eject the media until the 
operation finishes.

• Do not power the computer off until the operation 
finishes.

• On XDCAM EX devices, a frame near the specified 
frame may be displayed as the index picture, instead 
of the specified frame itself.

• If you press the Set Index Picture button during play 
of the clip, the thumbnail view may show no change 
before the play is finished.

Creating still images

It is not possible to create still images from a clip on 
XDCAM disc.

1 Play a clip in an Explorer window, and stop at the 
scene you want to use as the still image.

2 Do one of the following.

• Press the Capture Still Image button.
• Select [Capture Still Image...] from the [File] menu.

The Save Still Image dialog opens.

Note

Notes

Note

Notes

Note
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If the image is blurred
If the source clip is interlaced video (frame frequency: 
59.94i, 50i, etc.), you may be able to reduce the 
blurring by changing the Interpolated Field setting.
• 1st: Interpolate field 1 into field 2.
• 2nd: Interpolate field 2 into field 1.
• Frame: Create a composite of field 1 and field 2.

The Interpolated Field setting is fixed as “Frame” if 
the source clip is progressive video (frame frequency: 
59.94p, 50p, etc.)

3 Specify the file name and storage destination and click 
the [OK] button.

A bitmap still image is created from the frame selected 
in step 2.

Searching for clips

You can search for a clip in either of the following ways, 
depending on whether you know where the clip is located.
Folder search: When you know where the clip is located, 

you can search a specified folder for clips with 
specified properties.

Keyword search: When you know only the fact that the 
clip is located on the computer on which this 
application is installed, you can perform a keyword 
search.

Always observe the following precautions during a search.
• Do not delete the target folder.
• Do not eject the target media.

1 Activate an Explorer window and do one of the 
following.

• Click the Find button.
• Select [Find...] from the [Edit] menu.

The Find dialog opens.

2 Specify search criteria.

Specified Folder tab

To search a different folder: Click the [...] button to 
open a browse dialog, select the target folder, and 
click the [OK] button.

To specify search criteria: Select at least one item 
from the [Items] list, and enter the matching 
condition in the text box for that item, or select the 
condition from the list.

To specify the type of search: Click “Include all 
keywords” (AND search), “Include any of the 
keywords” (OR search), or “Exclude keywords” 
(NOT search).

To specify search options: As required, check “Case 
sensitive” and “Narrow down search” (narrow 
down the search within the results of the previous 
search).

When [Clip Name] is selected from the [Items] list, 
search is performed based on the [Clip Name] settings 
in the Display tab of the User Configuration dialog.

Keyword Searching tab

• On Windows XP, keyword search is available only 
when the latest version of Windows Desktop Search 
is installed.

• Keyword search uses Windows Desktop Search, so 
the search results depend on the functionality of 
Windows Desktop Search.

• Windows Desktop Search is an indexed search 
system. The index is updated at times when the 
computer is not being used for other tasks. 
Therefore, even if clips exist on the hard disk of the 
computer, they will not be found if they have not yet 
been indexed.

• Before performing a keyword search, register 
folders that contain clips in the Windows Desktop 
Search Options dialog, so that Windows Desktop 
Search will index the clips.

Refer to the Windows help for more information 
about Windows Desktop Search operations.

Note

Note

Note

Notes
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• The drives of XDCAM HD devices are not searched.

To specify the keywords to find: Enter the keywords 
to find in the Keywords box. You can enter 
multiple keywords. An AND search is performed 
(partial match). Uppercase and lowercase are not 
distinguished.

3 Click the [Start] button.

A list of search results appears in the Find dialog, 
containing clips that match the conditions specified in 
step 2.

To hide the search criteria in the Specified Folder 
tab
Click the [–] button.
Click the [+] button when conditions are hidden to 
show them again.

To sort the search results
Click the header of the column that you want to use as 
the sort key.
With each click, the list is sorted in ascending or 
descending order.

To display the search results in an Explorer 
window
Select one of the search results and do one of the 
following.
• Select [Go to Explorer] from the [Find] menu.
• Right click the result and select [Go to Explorer] 

from the context menu.

To play the search results
Select one of the search results and do one of the 
following.
• Select [Play] from the [Find] menu.
• Right click the result and select [Play] from the 

context menu.

Correcting flash bands

Flash banding can occur when the CMOS sensor of a 
camera or camcorder captures a subject that is illuminated 
by a flash or other momentary light source. It is 
characterized by a bright band at the top or bottom of a 
frame, instead of the entire frame. The term “flash band” is 
also used to describe a frame that is divided vertically into 
a bright half and a dark half.

This software creates copies of frames where flash banding 
has occurred, and corrects the flash banding on the copies. 
You can operate on multiple clips at once.

• Operations on MXF clips are not supported.
• Flash band detection and correction are not possible for 

the following clip types.
- Import material, material containing recorded line 

input signals, and so on
- Clips shot in 23.98p and converted to 59.94i by 2-3 

pulldown
- Write-protected clips, and clips on write-protected 

media
- Clips in the UserData folders on XDCAM drives

To detect flash bands automatically

1 In the List View pane of an Explorer window, select 
the clips that you want to check for flash bands.

2 In the [Clip] menu or the context menu, select [Flash 
Band], [Detect], and [In/Out section] or [All Range], 
in that order.

Flash band detection begins, and a progress bar 
appears to show the progress of the processing. 
A message appears when processing finishes.

Notes

Flash burst

Image capture time

Flash band
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• Editing of In and Out points is not supported for DV-
AVI clips. Regardless of range specifications, the 
entire clip is searched.

• Detection of all flash bands is not guaranteed. For 
example, this function may fail to detect flash bands 
in the following cases.
- When flash bands are located near the first or last 

frames
- When a section contains continuous flash bands
- When a scene has been shot with electronic shutter 

enabled
- When the scene changes dramatically between 

adjacent frames
- When the bright area caused by the flash is small 

in size
- When it is difficult for the software to determine 

whether a bright area is a flash band.

To check and edit detected flash bands

1 Load the clip that you want to check into the Preview 
window (see page 30).

2 Check that a Flash Band tab is displayed in the clip 
properties section, and click the Flash Band tab.

3 Click the [Load] button.

A list appears, showing the timecode locations of 
frames with detected flash bands.

4 Select a timecode value from the list in the Flash Band 
tab, and then check the picture that appears on the 
screen.

To check the picture after correction
Check the [Preview] check box, and then select the 
timecode of the frame that you want to check.

If you decide that correction is unnecessary
With the frame selected, click the [Delete] button, or 
select [Delete] from the frame’s context menu.

The information for that frame is deleted from the list 
and the position bar.

To correct a frame that was not detected
Display the frame that you want to correct, and then 
click the [Add] button.
Information for that frame is added to the list and the 
position bar. “Manual” appears in the Detect field of 
the list.

Image quality may be impaired if you correct where 
flash banding has not occurred.

To change the field where correction starts
If the correction target clip is interlaced video, from 
the context menu of the target frame, select [Field], 
and [1st] or [2nd], in that order.
Regardless of how the frame was added to the list, 
“Manual” appears in the Detect field whenever you 
change the correction start field.

5 If you changed anything in step 4, click the [Save] 
button.

The changes are not reflected if you execute the 
correction without performing this step.

To correct flash bands
After the preparations explained in the previous procedure, 
proceed as follows to execute the flash band correction.

1 In the List View pane of an Explorer window, select 
the clip to correct.

2 In the [Clip] menu or the context menu, select [Flash 
Band], [Correct], and [In/Out section] or [All Range], 
in that order.

The selected clip is duplicated, and flash band 
correction of the duplicated clip starts. A progress bar 
appears to show the progress of the processing.

• Editing of In and Out points is not supported for DV-
AVI clips. Regardless of range specifications, the entire 
clip is searched.

• No correction processing is performed on the 
duplication source clip.

• Flash band correction of the first and last frames is not 
supported.

• Depending on the flash burst characteristics, a white 
band may remain even after correction.

Notes

Number of corrected flash bands/
Number of detected flash bands

Marks indicating uncorrected flash bands

Note

Note
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To execute correction automatically after 
flash band detection
In step 2 of the procedure in “To detect flash bands 
automatically” (page 33), select the [Detect and Correct] 
command instead of the [Detect] command.
Correction starts automatically after automatic detection.

To check flash band corrected clips

1 In the Tree View pane of an Explorer window, select 
the folder or media where corrected clips are stored.

You can specify the destination where corrected clips 
are stored in the Flash Band tab of the User 
Configuration dialog. For details, see page 43.

2 Load the clip that you want to check into the Preview 
window (see page 30).

3 Click the Flash Band tab in the Preview window.

4 Click the [Load] button.

A list showing the timecode of correction target 
frames appears.
Check that the mark in position bar has changed to 
dark green (indicated flash band corrected), and that 
“Corrected” appears in the Status column.

5 Select the timecode and check the picture displayed on 
the screen.

Folder and Media 
Operations

Folder and media precautions
Always observe the following precautions during 
processing of folder and media operations.
• Do not power off the computer or media drive before the 

operation completes.
• Do not eject the media before the operation completes.

Folders for XDCAM EX clips

XDCAM EX clips are stored together with a BPAV folder 
(see page 39). (This folder does not appear in the Explorer 
window, but it can be seen in Windows Explorer.)
Whenever you copy or move clips with this application, 
the BPAV folder is copied or moved along with the clips. 
You cannot work with clips separately from the BPAV 
folder.

Simultaneous access to files may not be possible when you 
attempt to access the same folder at the same time from 
several computers over a network connection.

Folders for MXF clips

A folder for managing MXF clips must have three 
subfolders: Clip, Edit, and Sub (see page 40). Clips cannot 
be saved in the Clip subfolder unless they match the clips 
existing in that subfolder in terms of the following 
characteristics.
• Frame rate (NTSC/PAL/24p)
• Codec (MPEG IMX/DVCAM/HD4:2:0/HD4:2:2)
• Resolution width (coincidence of resolution height not 

required).
• Bit rate when the codec is MPEG IMX

These conditions are determined by the format of the clip 
first saved in the Clip subfolder. When copying MXF 
clips, it is necessary to check the source clips and the clips 
existing in the copy destination folder to be sure that these 
conditions are satisfied.

Creating folders

1 In the Tree View pane of an Explorer window, select 
the media or folder where you want to create the 
folder.

Number of corrected flash bands/
Number of detected flash bands

Marks indicating corrected flash bands

Status column

Note
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2 Do one of the following.

• Click the New Folder button.
• From the [File] menu, select [Folder] and then select 

[New Folder].
• Right click the media or folder and select [New 

Folder] from the context menu.

A new folder is created in the media or folder selected 
in step 1.

Reasons why a folder creation may fail
Folder creation operations may fail for the following 
reasons. In these cases, an error message appears and 
the folder is not created.
• You do not have write privileges for the selected 

media or folder.
• The selected media or folder is write protected.

• Folders cannot be created when writing is not allowed by 
the computer file system.

• New folders are created as normal folders. But when 
even one clip is copied or moved to the new folder, the 
folder is formatted as an XDCAM EX or XDCAM HD 
work folder. (The required subfolders and metadata files 
are created automatically.)

To rename a folder

1 Select a folder and do one of the following.

• From the [File] menu, select [Folder] and then select 
[Rename].

• Right click the folder and select [Rename] from the 
context menu.

The folder name is selected, so that now you can edit 
the name.

2 Enter a new name, and then press the Enter key or click 
somewhere outside the folder name.

• The name “BPAV” is reserved and cannot be 
specified.

• Characters forbidden by the operating system cannot 
be used in folder names.

• A folder name comprised of 200 or more characters 
may not be recognized.

To back up folders

1 In the Tree View pane of an Explorer window, select 
the folder that you want to back up.

2 Do one of the following.

• Select [Show in Windows Explorer...] from the 
[File] menu.

• Right click the folder and select [Show in Windows 
Explorer...] from the context menu.

Windows Explorer starts.

3 Perform your backup operations in Windows Explorer 
by copying the folder to other media or to another 
folder.

When a folder is too large to save to your backup 
media or folder
You can split the folder into smaller folders, and save them 
on separate discs. Split folders can later be combined to 
restore the original large folder.

See “Splitting folders” (page 37) and “Combining 
folders” (page 37) for more information.

Deleting folders

1 In the Tree View pane of an Explorer window, select 
the folder to delete.

2 Do one of the following.

• Press the Delete key.
• Click the Delete button.
• Select [Delete] from the [Edit] menu.
• Right click the folder and select [Delete] from the 

context menu.

A message appears asking if you want to execute the 
deletion.

3 Click the [Yes] button to execute the deletion, or the 
[No] button to cancel it.

Reasons why a folder deletion may fail
Folder deletion operations may fail for the following 
reasons. In these cases, an error message appears and 
folder is not deleted.
• You do not have delete/write privileges for the 

selected folder.
• The selected folder is write protected.
• Clips or other folders exist beneath the selected 

folder. 1)

Notes

Notes
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• Be careful when deleting folders, because all data in 
the folder is deleted.

• Deletions cannot be undone after they finish.

1) The following examples show two situations in which a folder (Work1) 
cannot be deleted.

When there is a file that is not managed by XDCAM EX devices

When there is another folder (Work2)

Normally, files which are not managed by XDCAM EX devices and 
folders such as Work2 must be deleted before the folder Work1 can be 
deleted. However, if you use Windows Explorer to create a folder or file 
in Work1 while this application is running, then Work1 may be deleted 
even while the folder or file still exists.

Splitting folders

You can split large folders into smaller folders. This allows 
you to back up all of the clips in a large folder to media that 
is not large enough to save the entire folder without 
splitting.
For example, you can split an 8 GB folder into two 4 GB 
folders in order to save them on 4 GB DVD-R media. Note 
that individual files in the large folder are not split.

This operation is limited to XDCAM EX clips. You cannot 
operate on clips in other formats (for example, XDCAM 
HD clips).

1 In the Tree View pane of an Explorer window, select 
the folder to split.

2 Do one of the following.

• Click the Split Folder button.
• Select [Split Folder...] from the [Clip] menu.
• Right click the folder and select [Split Folder...] 

from the context menu.

The Split Folder dialog opens.

The individual files in split folders are not split. Clips 
are assigned to the split folders in such a way that the 
split folders have the specified size. This means that it 
is not possible to specify a split folder size smaller than 
the largest file in the original folder. It is also not 
possible to specify a split folder size smaller than 4 
GB.

3 Select the type of media from the [Media] list box.

The size of the folder after splitting, as determined by 
the selected media type, appears in the edit box 
beneath the list box.
If you select “Arbitrary Size”, enter the size (an integer 
from 4 to 100) in the edit box.

4 Click the [Start] button.

The folder is split into the minimum number of folders 
that will produce the specified folder size, and clips are 
assigned to the smaller folders. The folders produced 
as a result of the split have the same name as the 
original folder, followed by serial numbers.

• Once it starts, a split operation cannot be canceled 
before it finishes.

• Split clips may be assigned to different folders. If 
you would prefer that split clips be assigned to other 
folders, you can move them manually after the 
folder split.

Combining folders

You can combine specified folders into another folder. 
This allows you to restore the original folder from split 
folders.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

Notes

Note

Work1

BPAV

File not managed by XDCAM EX devices

Work1

BPAV

BPAV

Work2

Note

Notes

Notes
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• To become the target of combination, folders must 
reside on the same directory level and be under the 
management of this application (see page 39).

1 In the Tree View pane of an Explorer window, select 
the destination folder, into which the other folders will 
be combined.

2 Do one of the following.

• Select [Combine Folders...] from the [Clip] menu.
• Right click the folder and select [Combine 

Folders...] from the context menu.

The Combine Folders dialog opens.

3 Check the check boxes of the folders that you want to 
combine into the folder selected in step 1. Check the 
[Delete folders after combine] check box if you want 
to delete the split folders after the combine.

The combined folders are not deleted when:
• They contain other folders.
• You do not have delete/write privileges to the 

original folders.
• The folders are write protected.

4 Click the [Start] button.

The folders selected in step 3 are combined into the 
destination folder specified in step 1. The clips in all of 
the folders are gathered into the destination folder. If 
any of the clips are split clips, they are automatically 
grouped, allowing them to be handled as a single clip.

Reasons why a folder combine operation may fail
Folder combine operations may fail for the following 
reasons. In these cases, an error message appears and 
the combine is not executed.
• There is not enough free capacity in the combine 

destination folder.
• You do not have write privileges to the source or 

destination folders.
• The source or destination folders are write protected.

• Multiple instances of the same clip exist.

Checking/editing disc metadata

You can check and edit the disc metadata 
(DISCMETA.XML) (see page 40) saved on XDCAM 
drives or in folders with MXF attributes.

1 In the Tree View pane of an Explorer window, select 
an XDCAM drive or a folder with MXF attributes.

2 Do one of the following.

• Select [Edit Disc Metadata...] from the [Edit] menu.
• Right click the XDCAM drive or folder with MXF 

attributes and select [Edit Disc Metadata...] from the 
context menu.

The Edit Disc Metadata dialog opens.

3 Edit the following items as required.

• User Disc ID (up to 127 bytes)
• Title 1 (up to 63 bytes)
• Title 2 (up to 127 bytes)
• Description (up to 2047 bytes)

4 Click the [OK] button.

Note
Folder and Media Operations
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Appendix

How XDCAM EX clip data are 
configured

Recording format 
This application supports the format specified for 
XDCAM EX devices. This format has the following 
specifications.
• Folder names and the folder configuration are as shown 

in the following figure.
• Files contain link information pertaining to links 

between files and folders.

• Do not use tools that do not support the XDCAM EX 
format to edit, delete, move, or rename the files and 
folders used by this application. Unless the format 
specifications are observed, files can become unreadable 
by XDCAM EX devices and by this application.

• It may not be possible for XDCAM EX devices to play 
clips that this application has created on, copied to, or 
moved to media other than SxS PRO memory cards.

Recording folders
The configuration of video and metadata folders is as 
shown in the following figure.
In the XDCAM EX format, the data beneath the BPAV 
folder is handled as a single set of data.

• One BPAV folder exists when a work folder is opened in 
Windows Explorer.

• To copy and backup your data, select the folders beneath 
the BPAV folder.

• When a work folder is selected in a Tree View pane of 
Explorer window, a list of clips registered in the BPAV 
folder appears in the corresponding List View pane. AV 
data is saved in the folders beneath the CLPR folder.

• On the media used by XDCAM EX devices, the BPAV 
folder is created beneath the root folder of the media.

• When MP4 files are imported to a work folder, new 
folders are created beneath the CLPR folder, and the 
imported clips are moved to those folders. Folder names 
are assigned automatically.

• When a work folder is selected in a Tree View pane of 
Explorer window and the CLPR folder in the work folder 
has some MP4 files, new folders are created beneath the 
CLPR folder, and the MP4 files are moved to those 
folders (the effect is the same as importing the MP4 
files).1)

• When unregistered AVI file exist in the CLPR folder, 
and that folder is accessed from an Explorer window, 
those AVI files are registered as management targets 
(processed like import files). However, importing cannot 
be performed if the file names do not follow the 
XDCAM EX naming conventions.

• On media supported by XDCAM EX devices, up to 600 
clips can be registered in one recording folder.

1) This process does not work in the UserData folders on XDCAM drives.

Folder and file names are linked to metadata files. Do not 
change them.

How MXF clip data are configured

Recording format
This application supports the format specified for 
XDCAM HD devices. This format has the following 
specifications.
• Folder names and the folder configuration are as shown 

in the following figure.
• Files contain link information pertaining to links 

between files and folders.

• Do not use tools that do not support the XDCAM HD 
format to edit, delete, move, or rename the files and 
folders used by this application. Unless the format 
specifications are observed, files can become unreadable 
by XDCAM HD devices and by this application.

• It may not be possible for XDCAM HD devices to play 
clips that this application has created on, copied to, or 

Notes

Media or work folder

Note

Notes
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moved to media other than Professional Discs (XDCAM 
drives).

Recording folders
The configuration of video and metadata folders is as 
shown in the following figure.

• This application recognizes a folder containing the three 
subfolders -- Clip, Edit, and Sub -- as a folder with MXF 
attributes, and browses the Clip folder.

• If XDCAM Drive in the General tab of the User 
Configuration dialog is set to “UserData”, this 
application browses the UserData folder instead of the 
Clip folder (see page 40).

• If file format conversion is executed by copying files to 
a normal folder (see page 24), DISCMETA.XML and 
MEDIAPRO.XML files, and Clip, Edit, Sub, and 
General folders are automatically created, and then the 
format-converted files are copied to the Clip folder. (For 
example, when the file named ABC0000.MP4 is copied 
to a work folder, the format is converted to MXF and the 
files named ABC0000.MXF and ABC0000M01.XML 
are automatically created and saved in the Clip folder.)

• Folder and file names are linked to metadata files. Do not 
change them.

• Even if you configure clip data like MXF clip data in an 
EX folder using Windows Explorer or other file 
management tools, this application gives priority to the 
XDCAM EX format so that you cannot operate MXF 
clips.

For details about the data configuration for MXF clips, 
refer to the Operating Instructions or Operation Manual 
supplied with the XDCAM HD device. 

User settings

The User Configuration dialog allows you to select 
application options and processing modes.
To open the User Configuration dialog, select [Options...] 
from the [Tool] menu.

General tab

XDCAM Drive: Specifies the folder on an XDCAM drive 
that this application will use.
• Clip: Uses the Clip folder. In this mode, only MXF 

clips on the XDCAM drive can be operated 
(XDCAM EX clips cannot be operated).
An “XDCAM Drive (normal)” icon is displayed in 
the Tree View pane (see page 14).

• UserData: Uses the UserData folder. In this mode, 
only XDCAM EX clips on the XDCAM drive can be 
operated (MXF clips cannot be operated). This mode 
is for backup of XDCAM EX clips.
An “XDCAM drive (UserData)” icon is displayed in 
the Tree View pane (see page 14).

For details about the data management structure for 
the XDCAM drive available in this application, see 
page 40.

Enable Snap function: Check this check box to enable the 
window snap function. The snap function works as 
follows.
• When you drag a window close to another window, 

the window snaps into position so that the windows 
edges come into contact.

• When you resize a window by dragging its border, 
neighboring windows are also resized while 
preserving the window layout.

Notes

Media or work folder
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Edit tab

Priority in Move: Specifies whether to give priority to 
operating speed or data protection when moving clips 
(see page 25).
• Processing speed: Normal move processing, without 

creating a duplicate of the clip
• Data protection: Creation of a duplicate before 

deletion of the original clip
Convert in MXF for copying EX to a normal folder: 

When EX format files are copied to a normal folder 
(without EX or MXF attributes) with this check box 
checked, the copies are automatically converted to the 
MXF format.

Perform CRC check after copy: When this check box is 
checked, the application performs a CRC (cyclic 
redundancy check) error check after copying a file, 
and displays a message if a copy error is detected.

Copy all files to: Specifies the destination folder for the 
Copy All command that copies all clips in a folder or 
on a media disc or memory card (see page 24). Enter a 
path beginning with a drive name in the edit box. Or 
click the [...] button to open a browse dialog, select a 
folder, and click the [OK] button.

Clip ID: Specifies up to four characters added to the start 
of imported clip names, and to the name of the folder 
where the imported clips are saved (see page 27).

Display tab

Clip Name: Specifies what to display as the clip name for 
each clip type.
• By Title: Displays the title as the clip name.
• By Filename: Displays the file name as the clip 

name.

Even if “By Title” is selected, the file name is 
displayed for a clip with no title assigned.

Metadata displayed to thumbnails: Displays list boxes 
that allow you to select metadata properties to be 
displayed on the first and second lines beneath 
thumbnails. The properties appear when thumbnails 
are displayed in the List View pane of an Explorer 
window. Select a property for each line from the 
following.
• Format
• Clip Name
• File Name
• Creation Date
• Bit Rate
• fps
• Resolution
• Duration

50p/60p Timecode Display Mode: Specifies the 
timecode display format when the frame frequency of 
the playback clip is 50p or 60p.
• Show all frames: The frame number increases on 

each frame. (Example of frame number display for 
60p clips: 00 t 01 t 02 t ... t 58 t 59 t 00 
t ...)

Note
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• Show *: The frame number increases on every 
second frame. An asterisk (*) is added to indicate the 
second frame in each frame number pair. (This is the 
display format used by Sony VTRs.) (Example of 
frame number display for 60p clips: 00 t 00* t 
01 t ... t 29 t 29* t 00 t ...)

When no more clips can be previewed: Specifies what to 
do when the number of clips in Preview windows 
(simultaneously open windows or tabs) exceeds the 
number that can be previewed at one time.
• Show a warning before replacing the clip that is 

being edited.
• Replacing the clip that was viewed first. (Do not 

show a warning)

Play tab

Resolution: Specifies the preview playback resolution. 
• Auto: Decodes the playback video at a resolution 

which is automatically adjusted to match the screen 
size.

• Normal: Decodes the playback video at the original 
resolution of the clip, regardless of the screen size.

• 1/2, 1/4: Decodes the playback video at half or 
quarter resolution. The image quality is lower, but 
response is better because of the lower demands 
placed on the decoder.

MXF Play mode: Specifies the playback mode of MXF 
clips.
• MPEG HD: Plays the clips at high resolution (plays 

MXF clips as is).
• Proxy: Plays the clips at low resolution (plays the 

proxy AV data).

For notes on the playback mode of MXF clips, see 
page 31.

Aspect Ratio: Selects the aspect ratios of the index and 
preview pictures of SD clips (DV-AVI format clips). 
Select from the following.
• Auto: Selects 16:9 or 4:3 automatically, according to 

the aspect ratio of the clip.

• 16:9
• 4:3

Conversion tab

Country: Specifies the video system adopted in the region 
where the application is used.
• NTSC (Include 24p)
• PAL

MP4 to MXF conversion by copy: Specifies the 
recording format to be used at the time of file format 
conversion from MP4 to MXF by a copy operation.
• Bit Rate

For files in the 4:2:0 color format, specifies the bit 
rate of the converted file when file format 
conversion is performed by a copy operation. Select 
from the following. (The bit rate for clips in the 4:2:2 
format is fixed at 50Mbps.)
- 18Mbps
- 25Mbps
- 35Mbps

• Format settings for empty destination folders
Specifies the recording format (frame rate and 
format) to be used when no clip exists at the copy 
destination during file format conversion by copy 
operation. The following combinations of the values 
can be set.
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For details about file format conversion by copy 
operation, see page 24.

Output OPAtom files to: Specifies the output folder for 
OPAtom files for the [Avid AAF] subcommand of the 
Export command (see next item “To set the media 
folder in Avid editing systems”). Enter a path 
beginning with a drive name in the edit box. Or click 
the [...] button to open a browse dialog where you can 
select a folder, and then click the [OK] button.

To set the media folder in Avid editing systems
For Avid Media Composer (V2.5.3 or later), proceed as 
follows.

1 Select [Media Creation] from the [Settings] menu.

The Media Creation dialog opens.

2 Specify the Video Drive/Audio Drive (media storage 
drive) in the Import tab.

• Windows XP: Any hard disk drive
• Windows Vista: Any hard disk drive except the 

drive where Windows Vista is installed

3 Import an MXF file into Avid Media Composer.

An “Avid Media Files\MXF\1” folder is created in the 
drive specified in step 2.
Specify this folder in the [Output OPAtom files to] 
box.

Flash Band tab

Where to save the corrected clips: Specifies the 
destination folder where this software will save 
duplicate clips created by the flash band correction 
function (see page 33).
• The same location as the original
• Specify the location: Enter a path beginning with a 

drive name in the edit box. Or click the [...] button to 
open a browse dialog where you can select a folder, 
and then click the [OK] button.

Country Frame Rate Format

NTSC 
(Include 24p)

60i/60p/30p 4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×720)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×720)

4:2:0 35Mbps (×1080)

4:2:2 50Mbps

24p 4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×1080)

PAL 50i/50p/25p 4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×720)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×720)

4:2:0 35Mbps (×1080)

4:2:2 50Mbps
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Menu list

This section lists the menus of this application as they 
appear when application windows are activated.

In the Keyboard shortcut field, the notation “Ctrl + N” 
means that the N key is pressed while holding down the 
Ctrl key.

Main window is only open window

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

File Exit – Alt + F4 Exits this application. Page 10

View Message Options Reset to the Default – Subsequently displays the 
message box which was set to be 
hidden by the setting of the [Do not 
show this message in the future.] 
check box.

–

Tool Options... – – Opens the User Configuration 
dialog.

Page 40

Window New Explorer Window – – Opens a new Explorer window. Page 12

New Preview Window – – Opens a new Preview window.

Help About Version... – – Displays the version of this 
application.

–

MainConcept Version... – – Displays the version of the 
MainConcept plug-in software.

–
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Explorer window is active

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

File Folder New Folder Ctrl + N Creates a new folder in the 
currently selected media or folder.

Page 35

Rename Ctrl + R Renames the selected folder. Page 36

Show in Windows 
Explorer...

– – Opens the selected folder in 
Windows Explorer, so that you can 
back up the folder contents.

Page 36

Import... – – Imports an MP4 file to the selected 
folder.

Page 27

Export MXF for NLEs... – Converts the selected clip to MXF 
format, for use on non-linear 
editors.

Page 28

MXF for XDCAM HD... – Converts the selected clip to 
XDCAM HD format.

MXF for XDCAM 
HD422...

– Converts the selected clip to 
XDCAM HD422 format.

MXF for XDCAM MPEG 
IMX...

– Converts the selected clip to 
XDCAM MPEG IMX format.

MXF for XDCAM 
DVCAM...

– Converts the selected clip to 
XDCAM DVCAM format.

Raw DV... – Converts the selected clip to RAW 
DV format.

AVI DV... – Converts the selected clip to AVI DV 
format.

Avid AAF... – Converts the selected clip to Avid 
AAF format.

Windows Media File... – Converts the selected clip to 
Windows Media file format.

Sony PSP (H.264/
AVC)...

– Converts the selected clip to a 
format for viewing on the 
PlayStation Portable (PSP) game 
console.

Apple iPod (H.264/
AVC)...

– Converts the selected clip to a 
format for viewing on the Apple 
iPod.

Video hosting service... – Converts the selected clip to a 
format for uploading to video 
hosting service.

Output... – – Opens the Output dialog. Page 17

Eject Media – – Ejects the media, or puts it into a 
state in which it can be safely 
removed.

–

Exit – Alt + F4 Exits this application. Page 10
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Edit Cut – Ctrl + X Cuts the selected clip. Page 25

Copy – Ctrl + C Copies the selected clip. Page 23

Paste – Ctrl + V Pastes a clip that has been cut or 
copied.

Page 23
Page 25

Delete – Delete Deletes the selected clip or folder. Page 26
Page 36

Copy All – Ctrl + Shift 
+ C

Copies all of the clips in the 
selected media or folder.

Page 24

Batch Edit Clip 
Properties...

– – Opens the Batch Edit Clip 
Properties dialog.

Page 22

Edit Disc 
Metadata...

– – Opens the Edit Disc Metadata 
dialog.

Page 38

Select All – Ctrl + A Selects all of the clips in the 
selected media or folder.

–

Find... – Ctrl + F Opens the Find dialog. Page 32

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page
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View Command Bar – – Shows or hides the tool buttons. Page 13

Folder Tree – – Shows or hides the Tree View pane. Page 14

Disk Space – – Shows or hides the disc capacity 
display.

Page 14

Status Bar – – Shows or hides the status 
information of the selected clip.

Page 14

Component View – – Shows or hides the Component 
View.

Page 14

Thumbnails – – Puts the List View pane into 
thumbnail view mode.

Page 15

List – – Puts the List View pane into list 
view mode.

Details – – Puts the List View pane into details 
view mode.

Sort by Clip Name – Sorts the clip list on the selected 
key, in ascending or descending 
order.Size –

Duration –

Status –

Creation date –

Last Update –

Rec Mode –

Media Spanning –

Save Sort Order – Saves the current sort order for the 
current folder.

–

Filter By Show All – Filter the display to show XDCAM 
EX clips in a specified file format.

–

MP4 –

DV-AVI –

Customize 
Columns...

– – Opens the Customize Columns 
dialog.

Page 16

Customize Tooltip... – – Opens the Customize Tooltip 
dialog.

Page 16

Message Options Reset to the Default – Subsequently displays the 
message box which was set to be 
hidden by the setting of the [Do not 
show this message in the future.] 
check box.

–

Up – Backspace Moves up one level in the folder 
hierarchy.

–

Refresh – F5 Refreshes the information displayed 
in the active tab of the Explorer 
window.

–

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page
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Clip New clip using In/
Out section

– – Creates a new clip from the section 
between In and Out points of the 
selected clip.

Page 26

Flash Band Detect In/Out 
section

– Detects frames where flash 
banding has occurred over the 
range from the In point to the Out 
point of the selected clip.

Page 33

All Range – Detects frames where flash 
banding has occurred over the 
entire range of the selected clip.

Correct In/Out 
section

– Corrects frames where flash 
banding has occurred over the 
range from the In point to the Out 
point of the selected clip.

All Range – Corrects frames where flash 
banding has occurred over the 
range from the entire range of the 
selected clip.

Detect and 
Correct

In/Out 
section

– Detects frames where flash 
banding has occurred over the 
range from the In point to the Out 
point of the selected clip, and then 
corrects those frames.

All Range – Detects frames where flash 
banding has occurred over the 
entire range of the selected clip, 
and then corrects those frames.

Split Folder... – Ctrl + W Splits the selected folder into 
folders of the specified size.

Page 37

Combine Folders... – Ctrl + J Combines the selected folder to 
another specified folder.

Page 37

Play – Space Plays the selected clip. Page 30

Tool Options... – – Opens the User Configuration 
dialog.

Page 40

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page
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Preview window is active

Window New Explorer 
Window

– – Opens a new Explorer window. Page 12

New Preview 
Window

– – Opens a new Preview window.

Close Window – Ctrl + F4 Closes the active window. –

New Tab – – Adds a new tab in the active 
window.

–

Close Tab – – Closes the active tab. –

Previous Tab – Ctrl + 
PageUp

Selects the previous tab. Page 13

Next Tab – Ctrl + 
PageDown

Selects the next tab. 

Optimize Window 
Layout

– – Optimizes the positions of Explorer 
and Preview windows in the main 
window.

Page 12

Cascade – – Arranges the currently open 
windows in cascading order from 
the upper left.

–

Tile Windows 
Vertically

– – Tiles the currently open windows 
vertically.

–

Tile Windows 
Horizontally

– – Tiles the currently open windows 
horizontally.

–

Help About Version... – – Displays the version of this 
application.

–

MainConcept 
Version...

– – Displays the version of the 
MainConcept plug-in software.

–

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

File Capture Still Image... – – Creates a bitmap still picture from 
the frame at the current position.

Page 31

Exit – Alt + F4 Exits this application. Page 10
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Edit Cut – Ctrl + X Cuts the selected text in the clip 
properties section of the General 
tab.

Page 20

Copy – Ctrl + C Copies the selected text in the clip 
properties section of the General 
tab.

Paste – Ctrl + V Pastes text that was cut or copied in 
the clip properties section of the 
General tab.

Delete – Delete Deletes the selected text in the clip 
properties section of the General 
tab.

Set Index Picture – P Sets the frame at the current 
position as the index picture.

Page 31

Mark In – I Sets an In point at the current 
position.

Page 26

Mark Out – O Sets an Out point at the current 
position.

Clear Mark In – Shift + I Clears the In point.

Clear Mark Out – Shift + O Clears the Out point.

Clear Mark In/Out – Shift + X Clears the In and Out points.

Add Essence Mark – E Sets an essence mark at the 
current position (up to 126).

–

Delete Essence Mark – Shift + E Deletes the essence mark at the 
current position.

–

View Full Screen – Alt + Enter Puts the Viewer into Full Screen 
mode.

Page 18

Message Options Reset to the 
Default

– Subsequently displays the 
message box which was set to be 
hidden by the setting of the [Do not 
show this message in the future.] 
check box.

–

Play Play – L or space Plays the selected clip. Page 30

Stop – K or space Stops clip play.

Play Reverse – J Plays the selected clip in the 
reverse direction.

Play In to Out – Shift + 
space

Plays the range from the In point to 
the Out point of the selected clip.

–1 Frame – T Steps one frame back.

+1 Frame – t Steps one frame forward.

Jump to Start – Home Jumps to the clip start point (first 
frame).

Jump to End – End Jumps to the clip end point (last 
frame).

Jump to In Point – R Jumps to the In point.

Jump to Out Point – r Jumps to the Out point

Previous Essence Mark – Shift + T Jumps to the previous essence 
mark.

Next Essence Mark – Shift + t Jumps to the next essence mark.

Set Audio Channels... – – Opens the Set Audio Channels 
dialog.

Page 31

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page
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Find window is active

Tool Options... – – Opens the User Configuration 
dialog.

Page 40

Window New Explorer Window – – Opens a new Explorer window. Page 12

New Preview Window – – Opens a new Preview window.

Close Window – Ctrl + F4 Closes the active window. –

Close Tab – – Closes the active tab. –

Previous Tab – Ctrl + 
PageUp

Selects the previous tab. Page 13

Next Tab – Ctrl + 
PageDown

Selects the next tab. 

Optimize Window Layout – – Optimizes the positions of Explorer 
and Preview windows in the main 
window.

Page 12

Cascade – – Arranges the currently open 
windows in cascading order from 
the upper left.

–

Tile Windows Vertically – – Tiles the currently open windows 
vertically.

–

Tile Windows 
Horizontally

– – Tiles the currently open windows 
horizontally.

–

Help About Version... – – Displays the version of this 
application.

–

MainConcept Version... – – Displays the version of the 
MainConcept plug-in software.

–

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

File Exit – Alt + F4 Exits this application. Page 10

View Search Criteria – – Shows or hides the search criteria. Page 32

Sort by Clip Name – Sorts the results list on the selected 
key, in ascending or descending 
order.Size –

Duration –

Status –

Creation date –

Last Update –

Rec Mode –

Media Spanning –

Folder Path –

Message Options Reset to the default – Subsequently displays the 
message box which was set to be 
hidden by the setting of the [Do not 
show this message in the future.] 
check box.

–

Find Start – – Starts the search. Page 32

Stop – – Stops the search.

Go to Explorer – – Opens the selected clip in an 
Explorer window.

Play – – Plays the selected clip.
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Error and warning message list

Tool Options... – – Opens the User Configuration 
dialog.

Page 40

Window New Explorer Window – – Opens a new Explorer window. Page 12

New Preview Window – – Opens a new Preview window.

Close Window – Ctrl + F4 Closes the active window. –

Cascade – – Arranges the currently open 
windows in cascading order from 
the upper left.

–

Tile Windows Vertically – – Tiles the currently open windows 
vertically.

–

Tile Windows 
Horizontally

– – Tiles the currently open windows 
horizontally.

–

Help About Version... – – Displays the version of this 
application.

–

MainConcept Version... – – Displays the version of the 
MainConcept plug-in software.

–

Menu Command Subcommand Keyboard 
shortcut

Function Reference 
page

Messages What to do

Failed to initialize OLE. Please confirm whether the OLE 
library version is correct.

There may be a problem with the installation of this application. Try 
installing it again.

Failed to read libraries for Export.

The folder contains some incomplete clips. Please copy all 
files in the [BPAV] folder under the selected folder to an 
SxS card and execute salvage operation on the recording 
equipment.

Data on the media is incomplete, probably because the XDCAM 
EX device was powered off during recording, or because the media 
was ejected prematurely. Return the media to the XDCAM EX 
device and salvage it immediately. The data may become 
unrecoverable if you continue to operate without salvaging it.Incomplete clip exists. Please execute salvage operation 

on the recording equipment.

Reason: The clip database is incorrect. The XDCAM EX format may be corrupt. Try to salvage the material, 
for example by importing an MP4 file to another folder.

Reason: The clip database created by other application. The selected clip database (registration folder) was not created by 
this application. Use the application that created the database to 
edit the clips and perform other clip operations.

Reason: The media may be incorrect or corrupted. The selected clip is in an unsupported format, or there is an error in 
the material data. Check the clip properties.

The clip cannot be displayed in Explorer. Check the properties of the selected clip. It cannot be imported or 
displayed in the list because the format is not compatible with the 
XDCAM EX format.

Failed to save sort order. Try restarting this application, or restarting the computer. If the 
problem persists, install the application again.

The copy destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

The drive specification is invalid, or no media is loaded in the drive. 
Specify an available drive, or load media into the drive.

The move destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

The import destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

Failed to output.
Reason: The output destination drive you specified 
doesn’t exist or isn’t ready.
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The clip database is incorrect, so it cannot be copied. The XDCAM EX format may be corrupt. Try to salvage the material, 
for example by importing an MP4 file to another folder.The clip database is incorrect, so it cannot be moved.

Failed to update properties.

A file exceeding 4 GB needs to be split, so the file cannot 
be copied.

Files larger than 4 GB cannot be managed on media like the SxS 
memory cards used by XDCAM EX devices. Use editing software 
or some other tool to split the file into files smaller than 4 GB and 
then try again.A file exceeding 4 GB needs to be split, so the file cannot 

be moved.

Because AVI clip is included, the clip cannot be created. This function does not support DV-AVI clips. Delete DV-AVI clips 
from the clip specification and try again.Because AVI clip is included, it cannot be copied 

converting to MXF.

Failed to create a clip. The operation was cancelled for one of the following reasons.
• You do not have delete and write privileges to the selected media 

or folder, or these operations are inhibited.
• The data is in an incompatible format, or it is corrupt.
Check the properties of the media or folder.

Reason: Unmatched frame rate. The selected clip cannot be copied due to difference in frame rate 
between that clip and clips existing in the copy destination folder. 
Check the frame rate (NTSC/24p/PAL) of the clip you want to copy 
and then perform copy by selecting a destination folder in which all 
the existing clips are of the same frame rate as the selected clip.

Reason: The video format is different. The selected clip cannot be copied due to difference in resolution 
between that clip and clips existing in the copy destination folder. 
Check the resolution of the clip that you want to copy and then 
perform copy by selecting a destination folder in which all the 
existing clips are of the same resolution as the selected clip.

Reason: Default format hasn’t been set. Please check 
Conversion tab in User Configuration.

Set the frame rate and bit rate in the [Rates to apply when rec 
format is unknown] section of the Conversion tab in the User 
Configuration dialog.

Reason: Bit Rate hasn’t been set. Please check 
Conversion tab in User Configuration.

Make settings in the [MP4 to MXF conversion bit rate] section of 
the Conversion tab in the User Configuration dialog.

MainConcept Conversion Pack is the trial version, so the 
conversion output may contain a watermark. For output 
without the watermark, please purchase the full version 
MainConcept Conversion Pack.

Purchase the full version plug-in software (MainConcept 
Conversion Pack #1 or #2) at the MainConcept website, and install 
it on your system. You can access the MainConcept website by 
selecting [MainConcept Version...] from the [Help] menu, and then 
clicking the URL in the dialog that appears.

Reason: Failed to convert. Check the recording format of the clip that you want to copy and 
that of the clips existing in the copy destination folder. File 
conversion may be disabled depending on the recording format of 
the original clip and the clips in the copy destination folder.

Reason: The clip is less than 2 seconds, so it cannot be 
written.

XDCAM devices do not support writing of clips shorter than two 
seconds.

It cannot be copied because a Clip less than 2 seconds is 
included.

UserData folder cannot be specified as the destination to 
copy MXF files. Please change the Copy All destination in 
User Configuration.

Change the setting in [Copy all files to:] of the General tab in the 
User Configuration dialog.

Failed to import the clip. Check the properties of the clip. You may not have access 
privileges to the clip, or the clip may be an MP4 file that is not 
compatible with the XDCAM EX format.

UserData folder cannot be specified as the output 
destination.

Change the output destination.

UserData folder cannot be specified as the destination to 
output OPAtom files. Please change the OPAtom file 
output destination in User Configuration.

Change the setting in [Output OPAtom files to:] of the Conversion 
tab in the User Configuration dialog.

Messages What to do
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The name is already used. Please specify another name. Specify another name or change the output destination.

xxxx already exists in the output folder. Please specify 
another name.

The file name is invalid or too long. The save destination may not be recognized if the full path to the 
save destination is too long. Change to a save destination with a 
shorter path name.

The list includes a clip that has 127 or more Essence 
Marks, so it cannot be output.

The output target list includes a clip with 127 or more essence 
marks. (The maximum number of essence marks that can be 
handled by this software is 126 per clip.) Delete the clip from the 
output target list. To include the clip in the output target list, delete 
unneeded essence marks to bring the total to 126 or fewer.

Error occurred during the export. Please refer to the 
details from the context on each clip.

Open the export dialog to check the report which is displayed when 
[Error detail] is selected from the context menu of the clip with the 
error.

Reason: An error occurred during conversion. The conversion failed for one of the following reasons.
• You do not have delete and write privileges to the output folder, 

or these operations are inhibited.
• The selected clip is in an unsupported format, or the material 

data is corrupt.
Check the properties of the folder and clip.

Reason: Unsupported XDCAM. The selected XDCAM drive is not supported.

Reason: Unsupported codec. The codec of the selected clip on the XDCAM drive is not 
supported.

Failed to create a folder. Check the properties of the selected media or folder. You may not 
have delete and write privileges to the media or folder, or these 
operations may be inhibited.

You cannot use [XXX] as a folder name. Please specify 
another name.

Specify a name other than “BPAV”.

It contains a string reserved by the system, so it cannot be 
set.

The name contains characters reserved by the operating system. 
Enter a name that does not contain these characters.

Reason: The clip file name has already been reserved. Change the file name or copy destination.

Failed to change the folder name. Check the properties of the selected folder. You may not have 
delete and write privileges to the folder, or these operations may be 
inhibited.Failed to delete the folder.

Failed to split the folder.

Failed to combine the folders. Check the properties of the combine source or destination folder. 
You may not have delete and write privileges to these folders, or 
these operations may be inhibited.

[XXX] contains a work folder, so it cannot be deleted. The selected media or folder contains one or more folders that are 
not under the management of this application. Delete or move 
these folders and then try again.Reason: [XXX] has a sub folder.

The folder [XXX] cannot be split. Reason: The folder 
contains a file exceeding the specified split unit of [XXX 
GB]. Clip name: 

The folder cannot be split into folders of the specified size because 
at least one file larger than that size exists. Specify a split size that 
is larger than the size of the largest file.

Failed to save disc metadata. Check the properties of the selected XDCAM drive and the state of 
the write protect tab on the disc. You may not have delete and write 
privileges for the selected XDCAM drive, or these operations may 
be inhibited.

The management information will be updated. If the media 
is write protected, please unlock the write protection 
before proceeding this operation.

If the selected media or folder is access protected or write 
protected, unlock and try again.

Reason: The number of audio samples is not enough. The audio after conversion may contain noise, because the number 
of audio samples is lower than the specified number. Check the 
number of audio samples in the conversion source clip.

Failed to eject xxxx. The media is in use. Please make 
sure that the file is not being accessed.

If a media clip is being accessed, stop the access.

Messages What to do
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How to obtain the plug-in software

The optional MainConcept plug-in software can be 
purchased and downloaded from the following website. 
You can access this website by selecting [MainConcept 
Version...] from the [Help] menu, and then clicking the 
URL in the dialog that appears.
http://www.mainconcept.com/plugin4clipbrowser

Licenses

MPEG-4 Visual Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 
VISUAL PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NONCOMMERCIAL USE OF A 
CONSUMER FOR
(i) ENCODING VIDEO IN COMPLIANCE WITH THE 

MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”)
AND/OR
(ii)DECODING MPEG-4 VIDEO THAT WAS 

ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY 
AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED BY MPEG LA TO PROVIDE 
MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING THAT 
RELATING TO PROMOTIONAL, INTERNAL AND 
COMMERCIAL USES AND LICENSING MAY BE 
OBTAINED FROM MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/sales 
of any storage media storing MPEG-4 Visual video 
information (ii) distribution/broadcasting of MPEG-4 
Visual video information in any manner (such as online 
video distribution service, internet broadcasting, TV 
broadcasting). Other usage of this product may be required 
to obtain license from MPEGLA. Please contact MPEG 
LA for any further information. MPEG LA, L.L.C., 250 
STEELE STREET, SUITE 300, DENVER, COLORADO 
80206, http://www.mpegla.com

MPEG-2 Video Patent Portfolio License
ANY USE OF THIS PRODUCT OTHER THAN 
CONSUMER PERSONAL USE IN ANY MANNER 
THAT COMPLIES WITH THE MPEG-2 STANDARD 
FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED 
WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG LA, 

L.L.C., 250 STEELE STREET, SUITE 300, DENVER, 
COLORADO 80206.

AVC Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A 
CONSUMER TO
(i) ENCODE VIDEO IN COMPLIANCE WITH THE 

AVC STANDARD (“AVC VIDEO”)
AND/OR
(ii)DECODE AVC VIDEO THAT WAS ENCODED BY 

A CONSUMER ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL 
INFORMATION MAY BE OBTAINED FROM MPEG 
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM

VC-1 Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE VC-1 
PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A 
CONSUMER TO
(i) ENCODE VIDEO IN COMPLIANCE WITH THE VC-

1 STANDARD (“VC-1 VIDEO”)
AND/OR
(ii)DECODE VC-1 VIDEO THAT WAS ENCODED BY 

A CONSUMER ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE VC-1 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL 
INFORMATION MAY BE OBTAINED FROM MPEG 
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM
55Appendix



For Mac OS
How to use the application on Mac OS



  F
or M

ac O
S

Introduction

Purpose of this manual

This manual explains how to use the XDCAM EX Clip 
Browsing Software on Mac OS. This manual is intended 
for users who will use this application to perform file and 
folder operations. It assumes that readers have a basic 
familiarity with Mac OS.

Notation for special keys

This manual uses the following notation to indicate special 
keys.

Notes on use of XDCAM devices

• This software cannot access an XDCAM HD device 
while another XDCAM-compatible application 
(XDCAM Transfer) is accessing that device.

• While running this software, if it becomes necessary to 
connect/disconnect the i.LINK cable or power on/off the 
XDCAM device, always do such operations after you 
exit this software.

Overview

The XDCAM EX Clip Browsing Software allows you to 
work with clips created with XDCAM EX/XDCAM HD 
devices.
After installing this application on your computer, you can 
use its intuitive graphical user interface to organize your 
clips by copying, moving, and deleting them. You can also 
perform format conversions, preview the clips, and view 
their metadata.
This software supports the following clip formats.

a) Referred to in this manual as “DV-AVI clips” or “DV-AVI files”.
b) Some functions are not supported.

Media (such as SxS memory cards) that contains HQ 1440 
clips or DV-AVI clips is not recognized as usable media by 
the PMW-EX1/EX3/EX30.

New functions supported in Version 
2.6

The following table shows the principal new functions 
supported in Version 2.6.

Symbol Notation in this manual

Command

Shift

Option

Control

Return

Clip File format Extension

XDCAM EX format 
compatible clips

MP4 mp4

DV-AVI Type2 a), b) avi

XDCAM HD format clips MXF b) mxf

Note

Function Description Reference

DV-AVI clip 
operations

Preview and other 
operations are 
supported for DV-AVI 
clips. However, some 
operations are not 
available.

–

Export of clip lists You can export lists of 
the clips on media and 
in folders. The lists are 
exported as XML files 
and style sheets, and 
they can be viewed and 
printed in Safari.

Page 66

Display of 
acquisition 
metadata

You can display the 
acquisition metadata of 
MP4 clips for each 
frame as an animation 
or in text format.

Page 71
57Introduction / Overview
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 Hardware and software 

requirements

Install this application on a computer meeting the 
following hardware and software requirements.

a) Mac OS is a trademark of Apple Inc., registered in the U.S. and other 
countries.

b) Intel is a registered trademark of Intel Corporation in the United States and 
other countries. Core is a trademark of Intel Corporation in the United 
States and other countries.

c) When viewing or printing exported clip information

All product names and brand names are registered 
trademarks or trademarks of their respective owners.

XDCAM devices supported by the 
application

This application supports the following XDCAM devices:

The mixed format recording mode of the XDCAM HD422 
series is not supported. When an XDCAM device is in 
mixed format recording mode, it may not be possible to 
specify the device as the destination of a copy or move 
operation.

Batch editing of clip 
properties

You can perform batch 
editing of the properties 
(Status, Title 1, Title 2, 
Creator, and 
Description) of MP4 
and MXF files.

Page 71

Flash band 
correction

You can correct frames 
that display the flash 
banding that 
sometimes occurs in 
MP4 and DV-AVI files.

Page 82

Item Description

OS Mac OS X 10.4.11 or higher, 10.5.1 or higher, 
or 10.6 or higher a)

CPU Intel Core 2 Duo Processor 2.0 GHz or higher 
(Intel Core 2 Duo Processor 2.4 GHz or higher 
recommended) b)

Memory 1 GB or more (2 GB or more recommended)

Other Safari 4.0.2 or higher c)

Series name Model name

XDCAM HD422 (Version 1.2 or higher) PDW-F800

PDW-700

PDW-F1600

PDW-HD1500

PDW-HR1

XDCAM HD (Version 1.92 or higher) PDW-F355L

PDW-F335L

PDW-F335K

PDW-F75

XDCAM HD Drive PDW-U1

Function Description Reference Note
Overview



  F
or M

ac O
S

Installing the Application

If the MainConcept plug-in software is installed
If you have purchased the plug-in software, access the 
following URL and update it to the latest version. You can 
access this website by selecting [About MainConcept 
Conversion Packs] from the [XDCAM EX Clip Browser] 
menu, and then clicking the URL in the dialog that 
appears.
http://www.mainconcept.com/plugin4clipbrowser

If Version 1.0x is installed
Uninstall Version 1.0x (1.00 or 1.01) (see page 60) before 
you start the installer.

Installing from the CD-ROM

1 Insert the supplied CD-ROM into the CD-ROM drive 
of your computer.

The disc icon appears on your desktop.

2 Double click the disc icon.

The contents of the CD-ROM appear.

3 Double click index.htm.

The cover page appears in your browser.

4 Select and click [MAC OS X] from the XDCAM EX 
Clip Browsing Software Installer.

Finder starts and ClipBrowser.dmg appears.

5 Double click ClipBrowser.dmg.

Finder starts and ClipBrowser.pkg appears.

6 Double click ClipBrowser.pkg.

The installation screen appears.

7 Click the [Continue] button.

A license agreement screen appears.

8 Click the [Continue] button.

The following message appears.

9 Click the [Agree] button.

A screen appears in which you can select the 
installation destination.

10Click the installation destination volume.

11Click the [Continue] button.

The following screen appears.
59Installing the Application
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 12Click the [Install] button.

An authentication screen appears.

13Enter your name and password, and then click the 
[OK] button.

The following screen appears when the installation 
finishes.

14Click the [Close] button to close the dialog.

To uninstall the application
Move the installation destination folder of the application 
(default: /Applications/XDCAM EX Clip Browser) to the 
Trash.

Uninstalling the application also uninstalls the 
MainConcept plug-in software at the same time.

Launching and Exiting 
the Application

See “Installing the Application” (page 59) for more 
information about how to install the application.

Launching the application

Use Finder to open the XDCAM EX Clip Browser folder 
in the Applications folder, and double click XDCAM EX 
Clip Browser.
The application starts, and the operating windows (see 
page 61) appear.

It is not possible to launch more than one instance of this 
application at one time.

Exiting the application

Select [Quit XDCAM EX Clip Browser] from the 
[XDCAM EX Clip Browser] menu.

Do not power off the computer while a file operation is still 
underway. Files may be corrupted. Wait until the operating 
finishes, or cancel the operation, before powering off.

Note

Note

Note
Launching and Exiting the Application
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Names and Functions of Parts

Operating window configuration

The following figure shows the default configuration of 
the operating windows.

a Explorer windows
You can have up to ten Explorer windows open at one 
time. When you have more than one window open, you can 
convert them into tabs on one window.

For details, see “Explorer window” (page 62).

b Preview windows
You can have up to five Preview windows open at one 
time. When you have more than one window open, you can 
convert them into tabs on one window.

For details, see “Preview window” (page 67).

To customize the window configuration

To open another window
Select [New Explorer Window] or [New Preview 
Window] from the [File] menu. A new Explorer or 
Preview window opens.

To snap windows to each other
Drag one of the windows close to another window. The 
windows snap together when they approach each other.

To tab windows
You can convert windows of the same type (Explorer or 
Preview) into tabs in a single window.
To tab a window, drag it and drop it on another window.

1 Explorer windows

Menu bar

2 Preview window
61Names and Functions of Parts
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When one Preview window is already open, you can open 
a new Preview tab by doing one of the following in an 
Explorer window.
• Double click a media file in the List View pane.
• Select a media file in the List View pane, and then select 

[Play] from the [Preview] menu.

If the selected media file is already loaded into its own 
Preview window or a Preview tab, that window or tab is 
activated.

To convert a tabbed window back into a separate 
window
Drag the tab of the window that you want to separate away 
from the other window.

Other window operations
• Drag the window title bar to move a window.
• Resize a window by dragging on any window border.
• Maximize a window or return it to its original size by 

each clicking the + (zoom) button in the upper left 
corner.

• Close a window you do not need by clicking the x (close) 
button in the upper left corner.

The application remembers your most recent configuration 
and recreates it the next time it starts.

When the snap function is enabled
When you resize a window by dragging its border, 
neighboring windows are also resized while preserving the 
window layout.

You can disable the snap function. For details, see “User 
settings” (page 90).

You can operate with the Shift key pressed to temporarily 
reverse the snap function setting.
When the snap function is enabled: The function is 

temporarily disabled.
When the snap function is disabled: The function is 

temporarily enabled.

Keyboard shortcuts for selecting tabs
You can use keyboard shortcuts to select tabs.

To select the previous or next tab from the 
keyboard
Press Shift + Command + { or Shift + Command + }.

Explorer window

Explorer windows are where you operate on clips (files) 
and folders, and where you check clip metadata. You can 
operate on XDCAM EX/XDCAM HD format folders and 
media.

Tabbed windows

Tip
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a Tab
The tab displays the name of the media or folder that is 
selected in the Tree View pane.
When two or more Explorer windows are open, you can 
drag and drop the tab on another window to convert this 
window into a tab on the other window (see page 61).

b Toolbar
Contains tool buttons for operations on clips and folders.

About the Eject Media button
Regardless of the target drive, clicking this button has the 
same effect as using the operating system “Eject” function.

c Path
This is the full path to the media or folder that is selected 
in the Tree View pane.

d Capacity
Displays the used capacity and remaining capacity of the 
media selected in the Tree View pane.

e View buttons
Selects the List View pane view mode.

f Tree View pane
Displays a tree of media and folders contained in drives.
The following icons represent the type of the media or 
folder.

Tool buttons Function Reference

Icon Name

 

New Folder Creates a new 
folder in the 
currently selected 
media or folder.

Page 85

 

Find Opens the Find 
dialog.

Page 81

 

Copy All Copies all of the 
clips in the selected 
media or folder to a 
new folder. This 
application creates 
the new folder 
automatically.

Page 74

 

Cut Cut the selected 
clip.

Page 74

 

Copy Copy the selected 
clip.

Page 72

1 Tab

3 Path

2 Toolbar

6Tree View pane

4 Capacity

8 Information about 
selected clips

q; List View pane

7Folder type

5 View buttons

9Component 
View pane

 

Paste Pastes a clip that 
has been cut or 
copied to another 
media or folder.

Page 72
Page 74

 

Delete Delete the selected 
clip or folder.

Page 75
Page 86

 

Eject Media When an XDCAM 
drive or SxS 
memory card drive 
is selected in the 
Tree View pane, 
ejects the media or 
puts it into a state in 
which it can be 
safely removed (see 
“About the Eject 
Media button” 
below).

–

Buttons Function

Icon Name

 

Show/Hide 
Component 
View

Shows or hides the Component 
View.

 

View Filter Filters the display of XDCAM EX 
clips by file format (showing all 
clips, MP4 clips, or DV-AVI clips).

 

List View Switches the clip view mode 
(thumbnails/details).

Icon Type of media or folder

Hard disk drive

CD, DVD or Blu-ray Disc drive

Tool buttons Function Reference

Icon Name
63Names and Functions of Parts



64

  F
or M

ac O
S

The Tree View pane supports the same kinds of operations 
as the tree panel of Finder.

When you select a media item, a message may appear 
saying that salvage is required, and that you should salvage 
the media on the device that recorded it. This message 
appears when the data is defective, typically because the 
XDCAM EX device was powered off or the media was 
ejected too soon during recording. If this message appears, 
you should reinsert the media into the XDCAM EX device 
and attempt to salvage it as soon as possible. The data may 
become unrecoverable if you continue to work with it 
without salvaging it.

g Folder type
Displays the type of the folder being selected in the Tree 
View pane.
EX: Folder with EX attributes
MXF: Folder with MXF attributes

h Information about selected clips
Displays information about the clips that are selected in the 
List View pane (number of selected clips, total clip length, 
and total size).

The total clip length is an approximate value, so take it as 
an approximate guide.

i Component View pane
Displays the component files of a clip in temporal order.
To display this pane, select [Component View] from the 
[View] menu, or click the Show/Hide Component View 
button in the toolbar.

When a single DV-AVI file is selected in the List View 
pane, this pane displays thumbnails of the clip’s 
component files.

• This pane displays the component files of DV-AVI clips 
only.

• Copy, delete, and other file operations are not supported 
in the Component View pane.

j List View pane
Displays the clips in the media or folder that is selected in 
the Tree View pane. You can select either of the following 
view modes.
Thumbnail View: This view displays the index picture of 

each clip (or a thumbnail of the first frame) and three 
properties (by default, the duration, the clip name, and 
the date and time when the clip was shot).

You can select different clip properties to display. For 
details, see “User settings” (page 90).

Details View: This view displays an icon indicating the 
type and current state of the clip, the name of the clip, 
and its properties.

To switch the clip view mode
Do one of the following.
• Select [Thumbnails] or [Details] from the [View] menu.
• Click the List View button in the toolbar, and then select 

[Thumbnails] or [Details].

A mark for the clip status is displayed on the thumbnail or 
icon in either of the view modes.

XDCAM drive (normal)

XDCAM drive (UserData)

SxS memory card drive

Mass storage device (removable drive) 
connected by USB

Mounted network drive

Normal folder, not managed by this application

Folder with EX attributes

Folder with MXF attributes

Note

Note

Icon Type of media or folder

Notes
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a) Clips with OK status can be moved or deleted by this application.
b) When a clip spans several media discs or memory devices, parts on other 

discs or memory devices are not played back.
c) The file may be corrupt or thumbnail creation may have failed.
d) A clip that cannot be played or displayed properly by this application. 

Another application is using the clip file.

To sort the View list
Select one of the following items under [Sort By] in the 
[View] menu.
• Clip Name
• Size
• Duration
• Status
• Creation Date
• Last Update
• Recording Mode
• Media Spanning

View mode Icon Description

Details view Normal MP4 file

MP4 file with OK status a)

An MP4 file in which some of the 
video cannot be displayed.
However, the video that can be 
displayed is handled like a normal 
MP4 file, and clip operations are 
supported.

Abnormal MP4 file (without data, 
cannot be decoded, etc.)

Normal DV-AVI file

A DV-AVI file in which some of the 
video cannot be displayed. However, 
the video that can be displayed is 
handled like a normal DV-AVI file, 
and clip operations are supported.

Abnormal DV-AVI file (without data, 
cannot be decoded, etc.)

Normal MXF file

MXF file with OK status (as set on 
the XDCAM device) a)

An MXF file in which some of the 
video cannot be displayed.
However, the video that can be 
displayed is handled like a normal 
MXF file, and clip operations are 
supported.

Abnormal MXF file (without data, 
cannot be decoded, etc.)

View mode Thumbnail display 
example

Description

Thumbnails 
view

Normal clip

Clip with OK status a)

The first part of a clip 
that spans several 
media discs or 
memory devices. b)

The middle part of a 
clip that spans several 
media discs or 
memory devices. b)

The last part of a clip 
that spans several 
media discs or 
memory devices. b)

A clip in which some 
of the video cannot be 
displayed. However, 
the video that can be 
displayed is handled 
like a normal clip, and 
clip operations are 
supported.

A clip that cannot be 
loaded. The clip 
cannot be previewed, 
and its properties 
cannot be edited. c), d)
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To select the items to display in Details View
Open the dialog shown below by selecting [Customize 
Columns...] from the [View] menu, and then proceed as 
follows.

To select an item to display: Check the check box. You 
can click the [Show All] button to check all of the 
check boxes.

To select an item to hide: Clear the check box. You can 
click the [Hide All] button to clear all of the check 
boxes except “Clip Name”.

To change the display order: Click an item to highlight 
it, and click the [Up] or [Down] button.

To return to the default settings: Click the [Reset to 
Default] button.

To confirm the changes: Click the [OK] button.
To cancel the changes: Click the [Cancel] button.

To select the items to display in tooltips
You can select the items that appear in tooltips when the 
pointer is moved over a clip in the List View pane. Select 
[Customize Tooltip...] from the [View] menu to open the 
dialog shown below, and select the items that you want to 
display.

See the previous section “To select the items to display in 
Details View” for operations in the dialog.

To export a list of clips
You can export a list of the clips in a selected media or 
folder. The list is exported as two files (an XML file and a 
style sheet) and can be viewed and printed in Safari. 1)

1) This function has been tested on Safari 4.0.2.

1 In the Tree View pane of an Explorer window, select 
the media or folder that you want to use as the data 
source for the clip list.

2 In the List View pane, select the clips to include in the 
clip list. (You can skip this step if you want to output 
all clips, or all clips in the format selected by the 
current display filter.)

3 From the [File] menu, select [Output...].

The Output dialog opens.

4 Set the following items.

Output Destination
• Folder: Specifies the output folder. Enter a path 

beginning with a drive name in the edit box. Or click 
the [...] button to open a browse dialog where you 
can select a folder, and then click the [OK] button.

• Data Name: A new folder with this name is created 
in the output folder, and output files with this name 
(an XML file and a style sheet) are output to the new 
folder.

Due to browser limitations, it may not be possible to 
view clip lists properly when some characters are used 
in clip file names. We recommend that you use ASCII 
characters and numbers only in file names.

Output Option
• Thumbnails: Output clip thumbnails (JPEG files) in 

addition to text data.
• Detailed Essence Marks: Output detailed 

information about the essence marks in the clips.

Output Range
• All: All clips in the selected media or folder

Note
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• Displayed Clips (MP4/DV-AVI): Clips displayed in 
the List View pane

• Selected Clips: Clips selected in the List View pane

5 Click the [Execute] button to start the export.

A progress bar appears to show the progress of the 
export. The following dialog appears when the export 
finishes.

To display the XML file immediately after finishing 
this procedure
Check the [Display the output file.] check box.

6 Click the [OK] button to close the dialog.

To open the output files
In the folder named after the specified data name, double 
click either the .xml file or the .xsl file (both of which have 
the same name as the folder).
The file list appears in Safari, where you can view it or 
print it.

Preview window

Preview windows are where you preview clips and check 
clip information.

Notes about the Preview window
Playback in this window is preview playback. Note the 
following points.
• Depending on the performance of your computer and the 

processing load, dropped frames may occur, timecode 
may differ from the actual values, the clip may not be 
played smoothly, and some time may be required before 
the screen is updated.

• When the playback clip is defective, video breakup may 
occur and the playback may freeze.

• Not all of the original recorded video is played back 
when a split clip is played back.

• It may not be possible to play clips created on devices 
other than XDCAM EX devices.

• Improper playback may occur if the screen settings of 
your computer are changed during playback. If this 
occurs, restart the application.

a Tab
Displays the clip name.
When two or more Preview windows are open, you can 
drag and drop the tab on another window to convert this 
window into a tab on the other window (see page 61).

b Viewer
Previews clips (see next section).

c Clip name
Displays the clip name of the selected tab.

d Splitter
You can drag the splitter up and down to change the 
relative sizes of the viewer and the clip properties section.

e Clip properties section
Allows you to check clip properties (see page 69).

1 Tab

3 Clip name

2 Viewer

4 Splitter

5 Clip properties section
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Viewer

a Screen
Displays the playback video.
You can double click the screen or select [Full Screen] 
from the [View] menu to enlarge the size to full screen 
size.
To return to the original size, double click the screen again 
or press the Esc key.

b Clip type
Displays the type of the clip being viewed on the viewer.
XDCAM EX (MP4): XDCAM EX clip (MP4 file)
XDCAM EX (DV-AVI): XDCAM EX clip (DV-AVI 

file)
XDCAM HD/HD422: MPEG HD file created from 

XDCAM HD or XDCAM HD422 clip (MXF file)
XDCAM HD/HD422 Proxy: Proxy file created from 

XDCAM HD or XDCAM HD422 clip (MXF file)

c Number of essence marks
Displays the number of the essence marks set in the clip (in 
the format of: actually set number/maximum allowable 
number).

d Timecode
Displays the timecode of the current position (playline 
position), and the duration of the section between In and 
Out points in the clip. A counter value is displayed when 
no timecode is recorded in the clip.
For NTSC clips, a period (.) between the minutes and 
seconds of the current position indicates drop-frame, and a 
colon (:) indicates non-drop-frame.

It is possible to jump to a specified position by clicking the 
current position timecode, entering a numeric value, and 
pressing the Return key. (This operation is ignored when 
invalid timecode is entered.)

You can change the timecode display format. For details, 
see “User settings” (page 90).

e Position bar
Displays the time scale of the clip.
The following marks are shown on the position bar to 
provide information about the clip.

a) The display of flash band correction marks takes priority over display of 
essence mark marks.

f Playline
Displays the current position on the time scale.
You can drag the playline or click anywhere on the 
position bar to move to a desired position. Scrubbing 
(repeatedly dragging to the left and right) is also supported.

g Command buttons
These buttons perform various clip preview operations.
The functions of these buttons can also be accessed from 
the keyboard.

4 Timecode

5 Position bar

6 Playline

7 Command buttons

1 Screen

2 Clip type

3 Number of essence marks

Mark Meaning

In point

Out point

Essence mark a)

Timecode break point (discontinuous 
timecode)

Split point between component files (appears 
only when a DV-AVI file consists of several 
component files)

Flash band correction has not been applied a)

Flash band correction has been applied a)

Icon Button 
name

Keyboard 
operation

Function

Jump to 
Start

Home Jumps to the clip start 
point (first frame).
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a) Editing of edit points (In and Out points) and essence marks is not 
supported for the following clip types.
• Clips on XDCAM drives
• DV-AVI clips

b) The maximum number of essence marks that you can set in a single clip is 
as follows, depending on the clip format.
• XDCAM EX clip (MP4 file): 126 
• XDCAM HD clip (less than 126 seconds): the number of seconds + 1 

(for example, 46 marks for a 45-second clip)
• XDCAM HD clip (126 seconds or more): 126 

c) Index pictures cannot be set for DV-AVI clips.

Clip properties section

General tab

This tab displays general information about the clip.
• Index Picture: Displays the index picture of the clip, or a 

thumbnail of the first frame if no index picture has been 
set.

• Mark In: Displays a thumbnail of the In point, or a 
thumbnail of the first frame if no In point has been set.

• Mark Out: Displays a thumbnail of the Out point, or a 
thumbnail of the last frame if no Out point has been set.

• Clip Name
• Creation Date (date and time of creation)
• Last Update (date and time of most recent update)
• Duration (clip length)
• Status: Displays the clip status. You can select the status 

from among OK, NG, KEEP, and None.
• Title 1: Allows you to assign a title up to 63 ASCII bytes 

in length.
• Title 2: Allows you to assign a subtitle up to 127 bytes in 

length.
• Creator: Allows you to enter the name of the person who 

shot the clip, up to 127 bytes in length.
• Description: Allows you to enter a description of the 

scene depicted in the clip, up to 2047 bytes in length.

Jump to 
End

End Jumps to the clip end 
point (last frame).

Clear Mark 
In/Out a)

Shift + X Clears In and Out point 
settings. Can be done 
during play (play 
continues).

Jump to In 
point

R Jumps to the In point.

Jump to 
Out point

r Jumps to the Out point.

Mark In a) I Sets an In point at the 
current position. Can be 
done during play (play 
continues).

Play In to 
Out

Shift + 
Space

Plays the section from 
the In point to the Out 
point. (During play, the 
button icon lights 
green.) Stops play if 
clicked during play.

Mark Out a) O Sets an Out point at the 
current position. Can be 
done during play (play 
continues).

Play Space Plays the clip. (During 
play, the button icon 
lights green.) Stops play 
if clicked during play.

Add 
Essence 
Mark a)

E Adds an essence mark 
at the current position. b) 
Can be done during play 
(play continues). 
However, an essence 
mark cannot be set at a 
position where one 
already exists.

Delete 
Essence 
Mark a)

Shift + E Deletes the essence 
mark at the current 
position. Can be done 
during play (play 
continues).

Set Index 
Picture c)

P Sets the current frame 
as the index picture of 
the clip. Can be done 
during play (play stops).

Set Audio 
Channels

– Opens the Set Audio 
Channels dialog.

Icon Button 
name

Keyboard 
operation

Function

Capture 
Still Image

– Saves the frame at the 
current position as a 
bitmap file. This 
command opens a 
dialog where you can 
specify the file name 
and save destination. 
However, still images 
cannot be created from 
a clip on XDCAM disc.

Icon Button 
name

Keyboard 
operation

Function
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To save changes to the Status, Title 1, Title 2, Creator, and 
Description fields, you must click the [Update] button. The 
changes are discarded if you close the window or tab 
without clicking the [Update] button.

You can batch edit these properties if you wish to share 
them among all clips in a folder or on a media device. For 
details, see “To perform batch editing of clip properties” 
(page 71).

The properties of DV-AVI clips cannot be edited.

A/V Format tab

This tab displays information about the recording format 
of the clip.
• Video Format 
• Audio Format

Related Info tab

This tab displays information related to clip recording 
conditions.
• Model
• Lens Model
• Recording Mode
• Media Spanning
• File Name
• Number of Files
• UMID
• Key Frame
• User Bit
• Proxy AV Data
• Edit List
• Hard- & Software

Essence Mark tab

This tab displays a list of essence marks in the current clip, 
with the timecode of the essence marks and the associated 
comments.
You can select an essence mark in this list to move the 
playback position to that frame.
To edit a comment: Select an essence mark in the list and 

click the [Edit] button. This opens the Edit Comments 
dialog. Edit the comment in the dialog and click the 
[OK] button. The maximum length of comments is 32 
bytes. The edited comment appears in the Comment 
field.

To delete an essence mark: Select an essence mark in the 
list (you can select multiple essence marks by clicking 
with the Shift key held down), press the [Delete] 
button, and click [Yes] in the confirmation dialog that 
appears.

• Editing of essence mark comments is not supported for 
clips of the following types.
- Clips on XDCAM drives
- DV-AVI clips

• The only essence marks that can be displayed on 
XDCAM EX devices are “_ShotMark1” and 
“_ShotMark2”.

• During playback on XDCAM EX devices, essence 
marks set by this application are displayed next to the 
frames where they were set.

Note
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Acquisition tab: Animation View

Acquisition tab: Text View

You can display acquisition metadata for clips shot in the 
MP4 format. This data provides information about the 
conditions under which the clip was shot. By selecting 
from the list box at the top of the tab, you can switch 
between [Animation View] and [Text View].
• Model Name: Camera/Lens
• Video Format
• Date and Time
• Auto Mode: AE/AF/WB (auto exposure/auto focus/

white balance)
• Lens Setting: Macro/Opt.Extender (macro/optical 

extender)
• Lens Parameter: Iris/Focus/Zoom/Angle of View/

Focusing
• Filter Wheel: ND/CC (ND filter/CC filter)
• Capturing: Mode/Rate/Shutter (shooting mode/frame 

rate in Slow & Quick Motion shooting/shutter speed)
• Processing: Gain/Elec.Extender/White Balance/Black/

Gamma (gain/digital extender/white balance/black 
level/gamma)

• The Acquisition tab does not appear when the target clip 
is in the DV-AVI or MXF format.

• Acquisition metadata cannot be displayed for import 
material, material containing recorded line input signals, 
and so on.

Flash Band tab

This tab displays information about frames where flash 
banding has occurred. This tab appears only for MP4 and 
DV-AVI clips that allow flash band detection and 
correction.
• Timecode: Timecode of the frame where flash banding 

was detected (or timecode of a frame added by the user)
• Field: In the case of interlaced video, the field where 

correction starts (1st/2nd)
• Detect: The detection method (Auto/Manual)
• Status: Correction status (empty field, indicating not yet 

corrected/Corrected)

See “Correcting flash bands” (page 82) for information 
about operations.

To perform batch editing of clip properties
You can perform batch editing of the properties (Status, 
Title 1, Title 2, Creator, and Description) of clips in the 
selected folder or on the selected media.

The properties of DV-AVI clips cannot be edited.

1 In the Tree View pane of an Explorer window, select a 
media device or a folder.

2 In the List View pane, select the batch editing target 
clips. (You can skip this step if you want to edit all 
clips, or all clips in the format selected by the current 
display filter.)

3 From the [Edit] menu, select [Batch Edit Clip 
Properties...].

The Batch Edit Clip Properties dialog opens.
Notes

Note
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4 Select the edit range.

• All: All clips in the selected media or folder
• Displayed Clips (MP4): Clips displayed in the List 

View pane
• Selected Clips: Clips selected in the List View pane

5 Check the check box for each batch edit item that you 
want to change, and then select a value from the list 
box or enter a string in the edit box.

• Status: Select from among OK, NG, KEEP, and 
None.

• Title 1: Up to 63 ASCII bytes in length
• Title 2: Up to 127 bytes in length
• Creator: Up to 127 bytes in length
• Description: Up to 127 bytes in length

To overwrite existing settings
Check the [Overwrite the edited item] check box.
If this check box is cleared when the batch edit is 
executed, the changes made here are reflected only to 
empty fields.

6 Click the [Execute] button.

A confirmation message appears, asking if you want to 
execute the batch edit.

7 Click the [Yes] button to execute the batch edit, or 
click the [No] button to cancel it.

A progress bar appears to show the progress of the 
batch edit. A completion dialog appears when the 
processing finishes.

8 Click the [OK] button to close the dialog.

Clip Operations

Clip operation precautions
• Always observe the following precautions during 

processing of clip operations.
- Do not power off the computer or media drive before 

the operation completes.
- Do not use Finder or another file management tool to 

delete folders that contain the clips being processed.
- Do not eject the media before the operation completes.

• It may be possible to copy and move clips to media with 
this application even when the display on an XDCAM 
EX device indicates that the media is full. However, it 
will not be possible to play back or delete those clips 
when the media is inserted into the XDCAM EX device 
again (a message will appear saying that the media must 
be salvaged).

• For the folders created on a hard disk or other media by 
copying from XDCAM drive with Finder or other folder 
management tool, editing operations such as adding and 
deleting of clips cannot be performed.

• If the NAMING FORM menu item of an XDCAM HD 
device is set to “C**** (standard format)”, any user-
defined file names (names in a format other than C****) 
are changed automatically to the standard format 
(C****) when the clips are written to the XDCAM drive.

• Writing a 50p or 60p frame rate clip to XDCAM drive 
moves the essence marks and Out points at the odd 
frames to the previous or next even frames. For example, 
the essence mark at the 15th frame moves to the 14th, 
while the Out point at the 19th frame moves to the 20th. 
However, the Out point will be deleted if an essence 
mark already set at the move destination frame.

For details about the menu operations of the XDCAM HD 
device, refer to the Operating Instructions or Operation 
Manual supplied with the XDCAM HD device.

Copying clips

You can duplicate clips on your media or computer, and 
copy clips between media and the computer.

When copying MXF clips to XDCAM drive or a folder 
with MXF attributes, it is not possible to copy the clip of a 
different recording format from that of the clips in the 
destination. 

Note
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Grouping split clips by gathering them into one 
place
XDCAM EX devices automatically save video that 
exceeds 4 GB in size as multiple clips. If you collect these 
clips into one media or folder, they are automatically 
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate 
media” (page 76) for more information.

To copy selected clips

1 Select a clip to copy in the List View pane of an 
Explorer window.

• Abnormal clips can be selected, but they are not 
copied.

• The folder that contains the selected clips cannot be 
specified as the copy destination.

If you want to copy the clips to a new folder
Create a new folder in the copy destination media or 
folder.

See “Creating folders” (page 85) for more 
information about how to create folders.

2 Do one of the following.

• Drag the clips selected in step 1 and drop them in the 
List View pane of another window, or on a copy 
destination media or folder in the Tree View pane of 
the same window or another window.

• Click the Copy button. Then click the List View 
pane of another window, or a copy destination media 
or folder in the Tree View pane of the same window 
or another window, and click the Paste button of that 
window.

• Select [Copy] from the [Edit] menu. Then click the 
List View pane of another window, or a copy 
destination media or folder in the Tree View pane of 
the same window or another window, and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the 
copy.

3 Click the [Yes] button to execute the copy, or the [No] 
button to cancel it.

A dialog illustrating the progress of the copying opens 
when the copying starts.

Once it has been completed, you cannot undo the copy 
operation.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In 
these cases, an error message appears and the copy is 
not executed.
• There is not enough free capacity at the copy 

destination.
• A clip with the same name as one of the selected 

clips already exists at the copy destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the 
destination media or folders.

• The destination media or folder is write protected.

If you copy an XDCAM EX file to a copy 
destination with MXF attributes
Copying an XDCAM EX MP4 file to an XDCAM drive or 
an MXF folder automatically converts the file to the 
XDCAM HD format (MXF file). This makes EX material 
available on your XDCAM HD device more easily than 
the export function (see page 77).
Copied files have the same recording format as that of the 
existing files in the destination.1) However, the bit rates are 
determined as specified in [Bit Rate] under [MP4 to MXF 
conversion by copy] in the Conversion tab of the 
Preferences dialog (see page 92).

1) If no file exists in the destination, the bit rate is determined as specified in 
[Format settings for empty destination folders] under [MP4 to MXF 
conversion by copy] in the Conversion tab of the Preferences dialog.

When the [Convert in MXF for copying EX to a normal 
folder] check box in the Edit tab of the Preferences dialog 
(see page 90) is checked, even the files which are to be 
copied to a normal folder are converted to the MXF 
format. Since the clip management folders for the 
XDCAM HD device (see page 89) are automatically 
created, the files converted in this application can be 
viewed. (The files which were output to a normal folder by 
the export function cannot be viewed in this application.)

• DV-AVI format EX files cannot be converted into 
XDCAM HD format files.

Notes

Note

Tip
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• It is not possible to convert XDCAM HD files to the 
XDCAM EX format.

• File conversion may not be possible, depending on the 
combination of source format and target format.

• Unless the licensed plug-in from MainConcept is 
installed, the video after conversion contains a 
MainConcept watermark, and audio is silent after the 
first 30 seconds.

• File conversion may degrade the image quality.
• This copy operation takes longer to complete since it 

requires format conversion.
• The MXF files produced by converting XDCAM EX 

MP4 files to XDCAM HD format are MPEG HD files 
only. The conversion does not produce Proxy files.

To copy all the clips in media or folders
You can copy all of the clips in a folder or a media disc or 
card in a single operation. This is a convenient way to 
import all the clips in an SxS memory card to the hard disk 
of your computer.

1 In the Tree View pane of an Explorer window, select 
the media or folder that contains the clips you want to 
copy.

2 Do one of the following.

• Click the Copy All button.
• Select [Copy All] from the [Edit] menu.

A message appears asking if you want to execute the 
copy. Check the destination folder.

You can change the copy destination folder. See “User 
settings” (page 90) for more information.

3 Click the [Yes] button to execute the copy, or the [No] 
button to cancel it.

A dialog illustrating the progress of the copying opens 
when the copying starts.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail
Copy operations may fail for the following reasons. In 
these cases, an error message appears and the copy is 
not executed.
• There is not enough free capacity at the copy 

destination.

• A clip with the same name as one of the selected 
clips already exists at the copy destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the 
destination media or folders.

• The destination media or folder is write protected.

Copy error check option
For greater copy reliability, you can enable the CRC 
(cyclic redundancy check) error check option. However, 
copy operations take longer to complete when this option 
is enabled.

See “User settings” (page 90) for more information about 
this option.

Moving clips

You can move clips on your media or computer, and move 
clips between media and the computer.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• Clips with OK status can be moved by this application.

Grouping split clips by gathering them into one 
place
XDCAM EX devices automatically save video that 
exceeds 4 GB in size as multiple clips. If you collect these 
clips into one media or folder, they are automatically 
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate 
media” (page 76) for more information.

Move modes
You can specify whether to give priority to processing 
speed or to data protection when moving clips.
• Processing speed: Normal move processing, without 

creating a duplicate of the clip.
• Data protection: A duplicate of the clip is created before 

the original clip is deleted.

See “User settings” (page 90) for more information about 
the settings.

1 Select a clip to move in the List View pane of an 
Explorer window.

Notes
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• Abnormal clips can be selected, but they cannot be 
moved.

• The folder that contains the selected clips cannot be 
specified as the move destination.

If you want to move the clips to a new folder
Create a new folder in the move destination media or 
folder.

See “Creating folders” (page 85) for more 
information about how to create folders.

2 Do one of the following.

• Drag the clips selected in step 1, and while holding 
down the Shift key, drop them in the List View pane 
of another window, or on a move destination media 
or folder in the Tree View pane of the same window 
or another window.

• Click the Cut button. Then click the List View pane 
of another window, or a move destination media or 
folder in the Tree View pane of the same window or 
another window, and click the Paste button of that 
window.

• Select [Cut] from the [Edit] menu. Then click the 
List View pane of another window, or a move 
destination media or folder in the Tree View pane of 
the same window or another window, and select 
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the 
move.

3 Click the [Yes] button to execute the move, or the [No] 
button to cancel it.

A dialog illustrating the progress of the move opens 
when the move starts.

• Once it has been completed, you cannot undo the 
move operation.

• Do not exit this application during the move. Doing 
so can break the links between clips and their 
metadata. The link information for split clips can be 
lost, causing them to become abnormal clips. If the 
selected clips are important, we recommend that you 
set the move mode to data protection mode (see 
page 74).

To cancel the move operation
Click the [Cancel] button in the progress dialog.

Reasons why a move operation may fail
Move operations may fail for the following reasons. In 
these cases, an error message appears and the move is 
not executed.
• There is not enough free capacity at the move 

destination.
• A clip with the same name as one of the selected 

clips already exists at the move destination. Even if 
the clip names are different, clips are recognized as 
the same clip if they share the same ID (UMID).

• You do not have delete/write privileges to the source 
or destination media or folder.

• The source or destination media or folder is write 
protected.

Deleting clips

• Clips with OK status can be deleted by this application.
• Deleting a clip linked to edit lists deletes all the edit lists 

linked to the clip.

1 In the List View pane of an Explorer window, select a 
clip to delete.

2 Do one of the following.

• Press the Delete key with the Command key held 
down.

• Click the Delete button.
• Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to 
delete the clips.

3 Click the [Yes] button to execute the deletion, or the 
[No] button to cancel it.

It is not possible to undo the deletion once it has been 
completed.

Reasons why a delete operation may fail
Deletion operations may fail for the following reasons. 
In these cases, an error message appears and the 
deletion is not executed.

Notes

Notes

Notes

Note
75Clip Operations



76

  F
or M

ac O
S

• You do not have delete/write privileges to media or 
folder where the clips are stored.

• The media or folder where the clips are stored is 
write protected.

Grouping clips that have been split 
across separate media

When you have split clips that have been saved on separate 
media as a result of an extended recording session, you can 
group those clips by collecting them in a single location. 
You can collect split clips by copying them, by moving 
them, or by combining split folders. Grouped clips can be 
handled as a single clip. 

See “Copying clips” (page 72), “Moving clips” (page 74), 
and “Combining folders” (page 87) for more information 
about the operations.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• Split clips which are not continuous along the time axis 
are not grouped.

• Abnormal clips are not grouped.
• Clips with altered UMIDs are not grouped. Grouping is 

performed on the basis of the UMIDs of split clips, and 
not on the basis of their file names.

Creating clips by specifying ranges

You can create a new clip by setting In and Out points in 
an existing clip. The new clip can be handled in the same 
way as the original clip. This is a convenient way to create 
clips during online editing.

This operation is limited to MP4 clips. You cannot operate 
on clips in other formats (for example, DV-AVI clips and 
XDCAM HD clips).

1 Preview a clip in a Preview window (see page 80), 
click the Mark In button at the position you want to use 
as the first frame, and click the Mark Out button at the 
position you want to use as the last frame.

In and Out points are set in the clip.

You can also set the Out point by specifying the In 
point and duration.

Duration can be specified by clicking the timecode 
display of the duration, entering a numeric value, and 
pressing the Return key.

In and Out points cannot be set at the same frame. 
When you try to set an Out (or In) point at a frame 
where an In (or Out) point has been set, the Out point 
is automatically set at the next frame after the In point.

2 Play the section specified in step 1, and adjust the In 
point and Out point positions as required.

3 In the List View pane of an Explorer window, find the 
clip where you set the In and Out points, and click the 
clip to select it.

To create several clips in one batch operation
You can create several clips in one operation.
Carry out steps 1 and 2 in several clips stored in the 
same folder or on the same media, and then select 
those clips here.

4 From the [File] menu, select [New clip using In/Out 
section].

A confirmation message appears asking if you want to 
create the clips.

If the In and Out points are not set
The following message appears. If you choose to 
continue, the effect is the same as copying the 
complete original clip.

5 Click the [Yes] button to create a new clip, or the [No] 
button to cancel the operation.

A progress dialog opens when creation of the clip 
starts.

To cancel creation of the clip
Click the [Cancel] button in the progress dialog.

Reasons why a new clip operation may fail
Creation of a new clip may fail for the following 
reasons. In these cases, an error message appears and 
the clip is not created.

Notes

Note

Tip
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• There is not enough free capacity at the clip creation 
destination.

• You do not have delete/write privileges to the 
destination media or folders.

Importing clips

You can import XDCAM EX format compatible MP4 or 
DV-AVI files and register them as clips that can be 
handled by XDCAM EX devices.

This operation is limited to XDCAM EX clips. You cannot 
operate on clips in other formats (for example, XDCAM 
HD clips).

1 In the Tree View pane of an Explorer window, select 
the media or folder that contains the MP4 or DV-AVI 
files to be imported.

2 Do one of the following.

• Select [Import...] from the [File] menu.
• Click the media or folder while holding down the 

Control key, and select [Import...] from the context 
menu.

The Import dialog opens.

3 Select a file format from the [Files of type] list, and 
specify the MP4 or DV-AVI files to import by 
selecting them from the file list.

4 Click the [Start] button to start the import, or the 
[Cancel] button to cancel it.

A dialog illustrating the progress of the import 
operation opens when the import starts.

To cancel the import operation
Click the [Cancel] button in the progress dialog.

Reasons why an import operation may fail
File import operations may fail for the following 
reasons. In these cases, an error message appears and 
the files are not imported.
• You do not have delete/write privileges for the 

import destination media or folder.
• The import destination media or folder is write 

protected.

• This software checks import file for compatibility 
with the XDCAM EX format. Files that are found to 
be incompatible cannot be imported.

• The properties of imported clips are set 
automatically.

• The format of imported clips may not be fully 
compatible with the XDCAM EX format. In this 
case, it may not be possible to play imported clips on 
XDCAM EX devices and with this application.

• The file names of imported DV-AVI files may be 
changed to names that can be recognized by 
XDCAM EX devices.

Exporting clips

You can export files created on XDCAM EX devices for 
use in various other environments. (To export is to convert 
files into other formats and output them.)

Future versions will support additional video formats. For 
upgrade information, visit the website listed in the 
“Features” section of the Operating Instructions for your 
XDCAM EX device and on the cover page of the supplied 
CD-ROM.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• DV-AVI files are supported for “MXF for NLEs” only.

1 In the List View pane of an Explorer window, select a 
clip to export by clicking them.

2 Do one of the following.

• From the [File] menu, select [Export] and then select 
the format that you want to convert to.

• Click the clip while holding down the Control key, 
from the context menu, select [Export] and then 
select the format that you want to convert to.

See “File conversion formats” (page 79) for more 
information about the available conversion formats.

Note

Notes

Notes
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An export dialog opens for the selected format. (The 
figure below shows the dialog that opens when you 
choose [MXF for XDCAM HD422].)

3 Change the following settings as required.

Export to: Specifies the export destination folder. 
Enter a path beginning with a drive name in the 
edit box. Or click the [...] button to open a browse 
dialog where you can select a folder, and then 
click the [OK] button.

Make sure that the export destination media has 
adequate free space before you execute the 
export. An error occurs at the point where the free 
space is used up.

Type: Click the [Details...] button to open the Codec 
Detail dialog, set parameters as required, and then 
click the [OK] button. This item does not appear 
for some conversion formats.

Depending on the number of audio channels in 
the clip, the audio output corresponds as shown 
below to the setting of the [Channel] list in the 
[Audio] section.

Target of Export: Select [In/Out section] if you want 
to output the range between the In and Out points 
in the current clip. This item does not appear for 
some conversion formats.

To change the output file name
In the List View pane, do one of the following to make 
the file name changeable.
• Click the file name.
• Click the highlighted part while holding down the 

Control key to display the context menu and select 
[Modify the output filename] from the context 
menu.

Enter a new name, and press the Return key or click 
anywhere other than the file name. Extension does not 
need to be entered.

4  Click the [Execute] button to start the export.

A progress bar appears to show the progress of the 
export. The progress also appears in the [Status] 
column of the List View pane.

To cancel the export
Click the [Cancel] button.

If a file with the same name already exists at the 
output destination
A dialog appears to ask how you want to proceed.
Read the explanation in the dialog and click one of the 
buttons.

Note

Number 
of audio 
channels 
in clip

Setting in 
[Channel] 
list

Audio output

2 1CH Mixed signal of channels 1 
and 2

4 1CH Mixed signal of channels 1 
to 4

2CH Channel 1: Mixed signal 
of channels 1 and 3

Channel 2: Mixed signal 
of channels 2 and 4

Number 
of audio 
channels 
in clip

Setting in 
[Channel] 
list

Audio output
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• The optional MainConcept plug-in software must be 
installed to use some conversion formats (see page 100). 
Unless the licensed plug-in from MainConcept is 
installed, the video after conversion contains a 
MainConcept watermark, and audio is silent after the 
first 30 seconds.

• Depending on the specified parameters, image quality 
may be degraded due to the image compensation 
process.

• Converted files may not be exactly the same with native 
files in the target format.

• Video metadata may not be inherited after format 
conversion.

• Image quality may be degraded if format conversion 
requires re-encoding.

• Image quality may be degraded and duration may vary if 
files are converted to a format with a different bit rate, 
resolution, or frame rate parameters.

• Before exporting, ensure that the export destination 
media or folder is write enabled.

File conversion formats
File conversion formats can be selected with the Export 
subcommands in the following table.

a) When outputting the range between the In and Out points in the current 
clip, the duration may be prolonged after conversion.

b) Clips of two seconds or less can be converted to MXF files, but they 
cannot be written to export destination devices.

c) 23.98p clips can only be converted to a format with the same frame rate 
(23.98p).

Notes

Export 
subcommand

Extension 
after 
conversion

Description

MXF for NLEs a) mxf Converts to MXF file format 
without changing the bit 
rate, resolution or other 
parameters. This is for non-
linear editors that support 
MXF files only.

MXF for 
XDCAM HD b), c)

mxf Converts to an MXF format 
that is compatible with 
MXF files recorded by 
XDCAM HD devices.

MXF for 
XDCAM 
HD422 b)

mxf Converts to an MXF format 
that is compatible with 
MXF files recorded by 
XDCAM HD422 devices.

MXF for XDCAM 
MPEG IMX d)

mxf Converts to an MXF format 
that is compatible with 
MXF files recorded by 
XDCAM MPEG IMX 
devices.

MXF for XDCAM 
DVCAM d)

mxf Converts to an MXF format 
that is compatible with 
MXF files recorded by 
XDCAM DVCAM devices.

Raw DV dv Converts to RAW DV 
format.This is for DV format 
editing. Depending on the 
editing environment, use 
either this subcommand or 
the [AVI DV] subcommand.

AVI DV avi Converts to AVI Type-2 
format.This is for DV format 
editing. Depending on the 
editing environment, use 
either this subcommand or 
the [RAW DV] 
subcommand.

Avid AAF e) AAF/mxf Converts to the following 
two file formats.
AAF file: Use to load clips 

into Avid editing 
system. The extension 
is AAF, and the output 
destination is the 
media or folder 
specified in the Export 
dialog (see page 77). 
AAF files produced by 
the conversion can be 
registered in your Avid 
editing system project 
by dragging from 
Finder to a bin in the 
project.

MXF OPAtom file: The 
extension is mxf, and 
the output destination 
is the media or folder 
specified in the 
Conversion tab of the 
Preferences dialog 
(see page 92). 
Normally this is the 
media folder of your 
Avid editing system 
project.

For details, refer to the 
user’s manual of your 
editing system.

Windows Media 
File

wmv Converts to Windows 
Media Player 9 compatible 
format.

Sony PSP 
(H.264/AVC) f)

mp4 Converts to a format that 
allows clips to be 
previewed on the 
PlayStation Portable (PSP) 
game console from Sony 
Computer Entertainment.

Apple iPod 
(H.264/AVC) f)

mp4 Converts to a format that 
allows clips to be 
previewed on the iPod 
portable media player from 
Apple Inc.

Video hosting 
service

wmv Converts to a format 
optimized for Internet video 
hosting services.

Export 
subcommand

Extension 
after 
conversion

Description
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d) This application supports copying, deleting, and viewing properties of 
XDCAM MPEG IMX or XDCAM DVCAM clips. It does not support 
previewing and the other operations. Thumbnail creation fails.

e) Avid editing systems may refuse to import a clip that has already been 
exported to the editing system.

f) Improper playback may occur if the converted file is viewed on a viewer 
other than the specified devices.

Previewing clips

You can preview clips in the Preview window.
Several limitations apply to playback in the Preview 
window. 

For details, see “Notes about the Preview window” (page 
67).

To load clips into the Preview window
Display the clip that you want to preview in the Clip View 
pane of an Explorer window, and then do one of the 
following.
• Double click the clip.
• Click the clip and then press the Return key.
• Drag and drop the clip on a Preview window (this 

operation is disabled if multiple clips are selected).
• Click the clip while holding down the Control key, and 

select [Play] from the context menu.
• Click the clip and then press the space bar.

The clip is loaded into the Preview window (and playback 
starts, if you loaded the clip by selecting [Play] or pressing 
the space bar). The timecode of the current playback 
position (or a counter value) appears in the upper part of 
the screen, together with the duration of the section 
between In and Out points in the clip.

To stop play
Click the play button.

Smooth playback is not possible when previewing clips 
saved to DVD-R or CD-R discs.

To control the preview
You can use the following methods to control playback in 
the Preview window.
• Use the command buttons (see page 68) in the Preview 

window.
• Select an operation from the [Preview] menu.
• Drag the playline.
• Press the J, K, or L key.

J: Change the reverse playback speed. Each press selects 
–1, –2, –4, –8, or –16 times normal speed.

K: Stop playback.
L: Change the forward playback speed. Each press 

selects 1, 2, 4, 8, or 16 times normal speed.

No audio is output in playback at speeds greater than or 
equal to ±4 times normal speed.

To select full-screen playback
Double click the screen, or select [Full Screen] from the 
[View] menu.
To return to the original screen size, double click the 
screen or press the Esc key.

To change the playback mode of MXF clips
Select “MPEG HD (high resolution)” or “Proxy (low 
resolution)” in the Play tab of the Preferences dialog (see 
page 91).
Selecting “MPEG HD” makes it possible to preview high 
definition images when the screen size is enlarged.

• You cannot change the playback mode when a clip is 
being played.

• Clips without proxy AV data are played at high 
resolution regardless of this setting.

• Clips on XDCAM drive are played at low resolution 
regardless of this setting.

• High resolution data may not be played smoothly due to 
its large file size.

To select the audio channels to monitor during 
previews
In the Set Audio Channels dialog, check the L (left) or R 
(right) check box to monitor that channel.
To open the Set Audio Channels dialog, do one of the 
following.
• Select [Set Audio Channels...] from the [Preview] menu.
• Click the Set Audio Channels button.

Changing the index picture of a clip

You can change index pictures during clip previews.

The index pictures of DV-AVI clips cannot be changed.

Note

Note

Notes

Note
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1 Play a clip, and display the frame you want to use as 
the index picture.

2 Select [Edit] and then select [Set Index Picture] from 
the [Preview] menu, or click the Set Index Picture 
button.

The currently displayed frame becomes the clip’s 
index picture, and the Index Picture in the General tab 
of the clip properties section changes to show it.

• If you are previewing a clip that is stored on 
removable media, do not eject the media until the 
operation finishes.

• Do not power the computer off until the operation 
finishes.

• On XDCAM EX devices, a frame near the specified 
frame may be displayed as the index picture, instead 
of the specified frame itself.

Creating still images

It is not possible to create still images from a clip on 
XDCAM disc.

1 Play a clip in a Preview window, and stop at the scene 
you want to use as the still image.

2 Do one of the following.

• Press the Capture Still Image button.
• Select [Capture Still Image...] from the [File] menu.

The Save Still Image dialog opens.

If the image is blurred
If the source clip is interlaced video (frame frequency: 
59.94i, 50i, etc.), you may be able to reduce the 
blurring by changing the Interpolated Field setting.
• 1st: Interpolate field 1 into field 2.

• 2nd: Interpolate field 2 into field 1.
• Frame: Create a composite of field 1 and field 2.

The Interpolated Field setting is fixed as “Frame” if 
the source clip is progressive video (frame frequency: 
59.94p, 50p, etc.)

3 Specify the file name and storage destination and click 
the [OK] button.

A bitmap still image is created from the frame selected 
in step 2.

Searching for clips

You can search for a clip in either of the following ways, 
depending on whether you know where the clip is located.
Folder search: When you know where the clip is located, 

you can search a specified folder for clips with 
specified properties.

Keyword search: When you know only the fact that the 
clip is located on the computer on which this 
application is installed, you can perform a keyword 
search.

Always observe the following precautions during a search.
• Do not delete the target folder.
• Do not eject the target media.

1 Activate a Preview window and do one of the 
following.

• Click the Find button.
• Select [Find] and then select [Find...] from the [Edit] 

menu.

The Find dialog opens.

2 Specify search criteria.

Specified Folder tab

Notes

Note

Note

Note
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To search a different folder: Click the [...] button to 
open a browse dialog, select the target folder, and 
click the [OK] button.

To specify search criteria: Select at least one item 
from the [Items] list, and enter the matching 
condition in the text box for that item, or select the 
condition from the list.

To specify the type of search: Click “Include all 
keywords” (AND search), “Include any of the 
keywords” (OR search), or “Exclude keywords” 
(NOT search).

To specify search options: As required, check “Case 
sensitive” and “Narrow down search” (narrow 
down the search within the results of the previous 
search).

When [Clip Name] is selected from the [Items] list, 
search is performed based on the [Clip Name] settings 
in the Display tab of the Preferences dialog.

Keyword Searching tab

• Keyword search uses the Mac OS Spotlight which is 
an indexed search system. The index is updated at 
times when the computer is not being used for other 
tasks. Therefore, even if clips exist on the hard disk 
of the computer, they will not be found if they have 
not yet been indexed.

• The drives of XDCAM HD devices are not searched.

To specify the keywords to find: Enter the keywords 
to find in the Keywords box. You can enter 
multiple keywords. An AND search is performed 
(partial match). Uppercase and lowercase are not 
distinguished.

3 Click the [Start] button.

A list of search results appears in the Find dialog, 
containing clips that match the conditions specified in 
step 2.

To hide the search criteria in the Specified Folder 
tab
Click the [–] button.
Click the [+] button when conditions are hidden to 
show them again.

To sort the search results
Click the header of the column that you want to use as 
the sort key.
With each click, the list is sorted in ascending or 
descending order.

To display the search results in an Explorer 
window
Select one of the search results and do one of the 
following.
• From the [Edit] menu, select [Find] and then select 

[Go to Explorer].
• Click the result while holding down the Control key, 

and select [Go to Explorer] from the context menu.

To play the search results
Select one of the search results and do one of the 
following.
• Select [Play] from the [Preview] menu.
• Click the result while holding down the Control key, 

and select [Play] from the context menu.

Correcting flash bands

Flash banding can occur when the CMOS sensor of a 
camera or camcorder captures a subject that is illuminated 
by a flash or other momentary light source. It is 
characterized by a bright band at the top or bottom of a 
frame, instead of the entire frame. The term “flash band” is 
also used to describe a frame that is divided vertically into 
a bright half and a dark half.

This software creates copies of frames where flash banding 
has occurred, and corrects the flash banding on the copies. 
You can operate on multiple clips at once.

Note

Notes

Flash band

Flash burst

Image capture time
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• Operations on MXF clips are not supported.
• Flash band detection and correction are not possible for 

the following clip types.
- Import material, material containing recorded line 

input signals, and so on
- Clips shot in 23.98p and converted to 59.94i by 2-3 

pulldown
- Write-protected clips, and clips on write-protected 

media
- Clips in the UserData folders on XDCAM drives

To detect flash bands automatically

1 In the List View pane of an Explorer window, select 
the clips that you want to check for flash bands.

2 In the [Clip] menu or the context menu, select [Flash 
Band], [Detect], and [In/Out section] or [All Range], 
in that order.

Flash band detection begins, and a progress bar 
appears to show the progress of the processing. A 
message appears when processing finishes.

• Editing of In and Out points is not supported for DV-
AVI clips. Regardless of range specifications, the 
entire clip is searched.

• Detection of all flash bands is not guaranteed. For 
example, this function may fail to detect flash bands 
in the following cases.
- When flash bands are located near the first or last 

frames
- When a section contains continuous flash bands
- When a scene has been shot with electronic shutter 

enabled
- When the scene changes dramatically between 

adjacent frames
- When the bright area caused by the flash is small 

in size
- When it is difficult for the software to determine 

whether a bright area is a flash band.

To check and edit detected flash bands

1 Load the clip that you want to check into the Preview 
window (see page 80).

2 Check that a Flash Band tab is displayed in the clip 
properties section, and click the Flash Band tab.

3 Click the [Load] button.

A list appears, showing the timecode locations of 
frames with detected flash bands.

4 Select a timecode value from the list in the Flash Band 
tab, and then check the picture that appears on the 
screen.

To check the picture after correction
Check the [Preview] check box, and then select the 
timecode of the frame that you want to check.

If you decide that correction is unnecessary
With the frame selected, click the [Delete] button, or 
select [Delete] from the frame’s context menu.
The information for that frame is deleted from the list 
and the position bar.

To correct a frame that was not detected
Display the frame that you want to correct, and then 
click the [Add] button.
Information for that frame is added to the list and the 
position bar. “Manual” appears in the Detect field of 
the list.

Image quality may be impaired if you correct where 
flash banding has not occurred.

To change the field where correction starts
If the correction target clip is interlaced video, from 
the context menu of the target frame, select [Field], 
and [1st] or [2nd], in that order.
Regardless of how the frame was added to the list, 
“Manual” appears in the Detect field whenever you 
change the correction start field.

5 If you changed anything in step 4, click the [Save] 
button.

The changes are not reflected if you execute the 
correction without performing this step.

Notes

Notes

Note

Note

Marks indicating uncorrected flash bands

Number of corrected flash bands/
Number of detected flash bands
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To correct flash bands
After the preparations explained in the previous procedure, 
proceed as follows to execute the flash band correction.

1 In the List View pane of an Explorer window, select 
the clip to correct.

2 In the [Clip] menu or the context menu, select [Flash 
Band], [Correct], and [In/Out section] or [All Range], 
in that order.

The selected clip is duplicated, and flash band 
correction of the duplicated clip starts. A progress bar 
appears to show the progress of the processing.

• Editing of In and Out points is not supported for DV-
AVI clips. Regardless of range specifications, the entire 
clip is searched.

• No correction processing is performed on the 
duplication source clip.

• Flash band correction of the first and last frames is not 
supported.

• Depending on the flash burst characteristics, a white 
band may remain even after correction.

To execute correction automatically after 
flash band detection
In step 2 of the procedure in “To detect flash bands 
automatically” (page 83), select the [Detect and Correct] 
command instead of the [Detect] command.
Correction starts automatically after automatic detection.

To check flash band corrected clips

1 In the Tree View pane of an Explorer window, select 
the folder or media where corrected clips are stored.

You can specify the destination where corrected clips 
are stored in the Flash Band tab of the Preferences 
dialog. For details, see page 92.

2 Load the clip that you want to check into the Preview 
window (see page 80).

3 Click the Flash Band tab in the Preview window.

4 Click the [Load] button.

A list showing the timecode of correction target 
frames appears.
Check that the mark in position bar has changed to 
dark green (indicated flash band corrected), and that 
“Corrected” appears in the Status column.

5 Select the timecode and check the picture displayed on 
the screen.

Notes

Number of corrected flash bands/
Number of detected flash bands

Marks indicating corrected flash bands

Status column
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Folder and Media 
Operations

Folder and media precautions
Always observe the following precautions during 
processing of folder and media operations.
• Do not power off the computer or media drive before the 

operation completes.
• Do not eject the media before the operation completes.

Folders for XDCAM EX clips

XDCAM EX clips are stored together with a BPAV folder 
(see page 88). (This folder does not appear in the Explorer 
window, but it can be seen in Finder.)
Whenever you copy or move clips with this application, 
the BPAV folder is copied or moved along with the clips. 
You cannot work with clips separately from the BPAV 
folder.

Simultaneous access to files may not be possible when you 
attempt to access the same folder at the same time from 
several computers over a network connection.

Folders for MXF clips

A folder for managing MXF clips must have three 
subfolders: Clip, Edit, and Sub (see page 89). Clips cannot 
be saved in the Clip subfolder unless they match the clips 
existing in that subfolder in terms of the following 
characteristics.
• Frame rate (NTSC/PAL/24p)
• Codec (MPEG IMX/DVCAM/HD4:2:0/HD4:2:2)
• Resolution width (coincidence of resolution height not 

required).
• Bit rate when the codec is MPEG IMX

These conditions are determined by the format of the clip 
first saved in the Clip subfolder. When copying MXF 
clips, it is necessary to check the source clips and the clips 
existing in the copy destination folder to be sure that these 
conditions are satisfied.

Creating folders

1 In the Tree View pane of an Explorer window, select 
the media or folder where you want to create the 
folder.

2 Do one of the following.

• Click the New Folder button.
• From the [File] menu, select [Folder] and then select 

[New Folder].
• Click the media or folder while holding down the 

Control key, and select [New Folder] from the 
context menu.

A new folder is created in the media or folder selected 
in step 1.

Reasons why a folder creation may fail
Folder creation operations may fail for the following 
reasons. In these cases, an error message appears and 
the folder is not created.
• You do not have write privileges for the selected 

media or folder.
• The selected media or folder is write protected.

• Folders cannot be created when writing is not allowed by 
the computer file system.

• New folders are created as normal folders. But when 
even one clip is copied or moved to the new folder, the 
folder is formatted as an XDCAM EX or XDCAM HD 
work folder. (The required subfolders and metadata files 
are created automatically.)

To rename a folder

1 Select a folder and do one of the following.

• From the [File] menu, select [Folder] and then select 
[Rename].

• Click the folder while holding down the Control key, 
and select [Rename] from the context menu.

The folder name is selected, so that now you can edit 
the name.

2 Enter a new name, and then press the Return key or 
click somewhere outside the folder name.

• The name “BPAV” is reserved and cannot be 
specified.

• Characters forbidden by the operating system  
cannot be used in folder names.

• A folder name comprised of 200 or more characters 
may not be recognized.

Note

Notes

Notes
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To back up folders

1 In the Tree View pane of an Explorer window, select 
the folder that you want to back up.

2 Do one of the following.

• Select [Show in Finder...] from the [File] menu.
• Click the folder while holding down the Control key, 

and select [Show in Finder...] from the context 
menu.

Finder starts.

3 Perform your backup operations in Finder by copying 
the folder to other media or to another folder.

When a folder is too large to save to your backup 
media
You can split the folder into smaller folders, and save them 
on separate discs. Split folders can later be combined to 
restore the original large folder.

See “Splitting folders” (page 86) and “Combining 
folders” (page 87) for more information.

Deleting folders

1 In the Tree View pane of an Explorer window, select 
the folder to delete.

2 Do one of the following.

• Press the Delete key with the Command key held 
down.

• Click the Delete button.
• Select [Delete] from the [Edit] menu.
• Click the folder while holding down the Control key, 

and select [Delete] from the context menu.

A message appears asking if you want to execute the 
deletion.

3 Click the [Yes] button to execute the deletion, or the 
[No] button to cancel it.

Reasons why a folder deletion may fail
Folder deletion operations may fail for the following 
reasons. In these cases, an error message appears and 
folder is not deleted.

• You do not have delete/write privileges for the 
selected folder.

• The selected folder is write protected.
• Clips or other folders exist beneath the selected 

folder. 1)

• Be careful when deleting folders, because all data in 
the folder is deleted.

• Deletions cannot be undone after they finish.

1) The following examples show two situations in which a folder (Work1) 
cannot be deleted.

When there is a file that is not managed by XDCAM EX devices

When there is another folder (Work2)

Normally, files which are not managed by XDCAM EX devices and 
folders such as Work2 must be deleted before the folder Work1 can be 
deleted. However, if you use Finder to create a folder or file in Work1 
while this application is running, then Work1 may be deleted even while 
the folder or file still exists.

Splitting folders

You can split large folders into smaller folders. This allows 
you to back up all of the clips in a large folder to media that 
is not large enough to save the entire folder without 
splitting.
For example, you can split an 8 GB folder into two 4 GB 
folders in order to save them on 4 GB DVD-R media. Note 
that individual files in the large folder are not split.

This operation is limited to XDCAM EX clips. You cannot 
operate on clips in other formats (for example, XDCAM 
HD clips).

1 In the Tree View pane of an Explorer window, select 
the folder to split.

2 Do one of the following.

• Click the Split Folder button.
• Select [Split Folder...] from the [Edit] menu.

Notes

Note

Work1

BPAV

File not managed by XDCAM EX devices

Work1

BPAV

BPAV

Work2
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• Click the folder while holding down the Control key, 
and select [Split Folder...] from the context menu.

The Split Folder dialog opens.

The individual files in split folders are not split. Clips 
are assigned to the split folders in such a way that the 
split folders have the specified size. This means that it 
is not possible to specify a split folder size smaller than 
the largest file in the original folder. It is also not 
possible to specify a split folder size smaller than 4 
GB.

3 Select the type of media from the [Media] list box.

The size of the folder after splitting, as determined by 
the selected media type, appears in the edit box 
beneath the list box.
If you select “Arbitrary Size”, enter the size (an integer 
from 4 to 100) in the edit box.

4 Click the [Start] button.

The folder is split into the minimum number of folders 
that will produce the specified folder size, and clips are 
assigned to the smaller folders. The folders produced 
as a result of the split have the same name as the 
original folder, followed by serial numbers.

• Once it starts, a split operation cannot be canceled 
before it finishes.

• Split clips may be assigned to different folders. If 
you would prefer that split clips be assigned to other 
folders, you can move them manually after the 
folder split.

Combining folders

You can combine specified folders into another folder. 
This allows you to restore the original folder from split 
folders.

• This operation is limited to XDCAM EX clips. You 
cannot operate on clips in other formats (for example, 
XDCAM HD clips).

• To become the target of combination, folders must 
reside on the same directory level and be under the 
management of this application (see page 88).

1 In the Tree View pane of an Explorer window, select 
the destination folder, into which the other folders will 
be combined.

2 Do one of the following.

• Select [Combine Folders...] from the [Edit] menu.
• Click the folder while holding down the Control key, 

and select [Combine...] from the context menu.

3 Check the check boxes of the folders that you want to 
combine into the folder selected in step 1. Check the 
[Delete folders after combine] check box if you want 
to delete the split folders after the combine.

The combined folders are not deleted when:
• They contain other folders.
• You do not have delete/write privileges to the 

original folders.
• The folders are write protected.

4 Click the [Start] button.

The folders selected in step 3 are combined into the 
destination folder specified in step 1. The clips in all of 
the folders are gathered into the destination folder. If 
any of the clips are split clips, they are automatically 
grouped, allowing them to be handled as a single clip.

Reasons why a folder combine operation may fail
Folder combine operations may fail for the following 
reasons. In these cases, an error message appears and 
the combine is not executed.

Note

Notes

Notes

Note
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• There is not enough free capacity in the combine 
destination folder.

• You do not have write privileges to the source or 
destination folders.

• The source or destination folders are write protected.
• Multiple instances of the same clip exist.

Checking/editing disc metadata

You can check and edit the disc metadata 
(DISCMETA.XML) (see page 89) saved on XDCAM 
drives or in folders with MXF attributes.

1 In the Tree View pane of an Explorer window, select 
an XDCAM drive or a folder with MXF attributes.

2 Do one of the following.

• Select [Edit Disc Metadata...] from the [Edit] menu.
• Right click the XDCAM drive or folder with MXF 

attributes and select [Edit Disc Metadata...] from the 
context menu.

The Edit Disc Metadata dialog opens.

3 Edit the following items as required.

• User Disc ID (up to 127 bytes)
• Title 1 (up to 63 bytes)
• Title 2 (up to 127 bytes)
• Description (up to 2047 bytes)

4 Click the [OK] button.

Appendix

How XDCAM EX clip data are 
configured

Recording format 
This application supports the format specified for 
XDCAM EX devices. This format has the following 
specifications.
• Folder names and the folder configuration are as shown 

in the following figure.
• Files contain link information pertaining to links 

between files and folders.

• Do not use tools that do not support the XDCAM EX 
format to edit, delete, move, or rename the files and 
folders used by this application. Unless the format 
specifications are observed, files can become unreadable 
by XDCAM EX devices and by this application.

• It may not be possible for XDCAM EX devices to play 
clips that this application has created on, copied to, or 
moved to media other than SxS PRO memory cards.

Recording folders
The configuration of video and metadata folders is as 
shown in the following figure.
In the XDCAM EX format, the data beneath the BPAV 
folder is handled as a single set of data.

Notes

Media or work folder
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• One BPAV folder exists when a work folder is opened in 
Finder.

• To copy and backup your data, select the folders beneath 
the BPAV folder.

• When a work folder is selected in a Tree View pane of 
Explorer window, a list of clips registered in the BPAV 
folder appears in the corresponding List View pane. AV 
data is saved in the folders beneath the CLPR folder.

• On the media used by XDCAM EX devices, the BPAV 
folder is created beneath the root folder of the media.

• When MP4 files are imported to a work folder, new 
folders are created beneath the CLPR folder, and the 
imported clips are moved to those folders. Folder names 
are assigned automatically.

• When a work folder is selected in a Tree View pane of 
Explorer window and the CLPR folder in the work folder 
has some MP4 files, new folders are created beneath the 
CLPR folder, and the MP4 files are moved to those 
folders (the effect is the same as importing the MP4 
files).1)

• When unregistered AVI file exist in the CLPR folder, 
and that folder is accessed from an Explorer window, 
those AVI files are registered as management targets 
(processed like import files). However, importing cannot 
be performed if the file names do not follow the 
XDCAM EX naming conventions.

• On media supported by XDCAM EX devices, up to 600 
clips can be registered in one recording folder.

1) This process does not work in the UserData folders on XDCAM drives.

Folder and file names are linked to metadata files. Do not 
change them.

How MXF clip data are configured

Recording format
This application supports the format specified for 
XDCAM HD devices. This format has the following 
specifications.
• Folder names and the folder configuration are as shown 

in the following figure.
• Files contain link information pertaining to links 

between files and folders.

• Do not use tools that do not support the XDCAM HD 
format to edit, delete, move, or rename the files and 
folders used by this application. Unless the format 
specifications are observed, files can become unreadable 
by XDCAM HD devices and by this application.

• It may not be possible for XDCAM HD devices to play 
clips that this application has created on, copied to, or 

moved to media other than Professional Discs (XDCAM 
drives).

Recording folders
The configuration of video and metadata folders is as 
shown in the following figure.

• This application recognizes a folder containing the three 
subfolders -- Clip, Edit, and Sub -- as a folder with MXF 
attributes, and browses the Clip folder.

• If XDCAM Drive in the General tab of the Preferences 
dialog is set to “UserData”, this application browses the 
UserData folder instead of the Clip folder (see page 90).

• If file format conversion is executed by copying files to 
a normal folder (see page 73), DISCMETA.XML and 
MEDIAPRO.XML files, and Clip, Edit, Sub, and 
General folders are automatically created, and then the 
format-converted files are copied to the Clip folder. (For 
example, when the file named ABC0000.MP4 is copied 
to a work folder, the format is converted to MXF and the 
files named ABC0000.MXF and ABC0000M01.XML 
are automatically created and saved in the Clip folder.)

• Folder and file names are linked to metadata files. Do not 
change them.

• Even if you configure clip data like MXF clip data in an 
EX folder using Finder or other file management tools, 
this application gives priority to the XDCAM EX format 
so that you cannot operate MXF clips.

For details about the data configuration for MXF clips, 
refer to the Operating Instructions or Operation Manual 
supplied with the XDCAM HD device. 

Note

Notes

Notes

Media or work folder
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User settings

The Preferences dialog allows you to select application 
options and processing modes.
To open the Preferences dialog, select [Preferences...] 
from the [XDCAM EX Clip Browser] menu.

General tab

XDCAM Drive: Specifies the folder on an XDCAM drive 
that this application will use.
• Clip: Uses the Clip folder. In this mode, only MXF 

clips on the XDCAM drive can be operated 
(XDCAM EX clips cannot be operated).
An “XDCAM Drive (normal)” icon is displayed in 
the Tree View pane (see page 64).

• UserData: Uses the UserData folder. In this mode, 
only XDCAM EX clips on the XDCAM drive can be 
operated (MXF clips cannot be operated). This mode 
is for backup of XDCAM EX clips.
An “XDCAM drive (UserData)” icon is displayed  
in the Tree View pane (see page 64).

For details about the data management structure for 
the XDCAM drive available in this application, see 
page 88.

Enable Snap function: Check this check box to enable the 
window snap function. The snap function works as 
follows.
• When you drag a window close to another window, 

the window snaps into position so that the windows 
edges come into contact.

• When you resize a window by dragging its border, 
neighboring windows are also resized while 
preserving the window layout.

Edit tab

Priority in Move: Specifies whether to give priority to 
operating speed or data protection when moving clips 
(see page 74).
• Processing speed: Normal move processing, without 

creating a duplicate of the clip
• Data protection: Creation of a duplicate before 

deletion of the original clip
Convert in MXF for copying EX to a normal folder: 

When EX format files are copied to a normal folder 
(without EX or MXF attributes) with this check box 
checked, the copies are automatically converted to the 
MXF format.

Perform CRC check after copy: When this check box is 
checked, the application performs a CRC (cyclic 
redundancy check) error check after copying a file, 
and displays a message if a copy error is detected.

Copy all files to: Specifies the destination folder for the 
Copy All command that copies all clips in a folder or 
on a media disc or memory card (see page 74). Enter a 
path beginning with a drive name in the edit box. Or 
click the [...] button to open a browse dialog, select a 
folder, and click the [OK] button.

Clip ID: Specifies up to four characters added to the start 
of imported clip names, and to the name of the folder 
where the imported clips are saved (see page 77).
Appendix
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Display tab

Clip Name: Specifies what to display as the clip name for 
each clip type.
• By Title: Displays the title as the clip name.
• By Filename: Displays the file name as the clip 

name.

Even if “By Title” is selected, the file name is 
displayed for a clip with no title assigned.

Metadata displayed to thumbnails: Displays list boxes 
that allow you to select metadata properties to be 
displayed on the first to third lines beneath thumbnails. 
The properties appear when thumbnails are displayed 
in the List View pane of an Explorer window. Select a 
property for each line from the following.
• Format
• Clip Name
• File Name
• Creation Date
• Bit Rate
• fps
• Resolution
• Duration

50p/60p Timecode Display Mode: Specifies the 
timecode display format when the frame frequency of 
the playback clip is 50p or 60p.
• Show all frames: The frame number increases on 

each frame. (Example of frame number display for 
60p clips: 00 t 01 t 02 t ... t 58 t 59 t 00 
t ...)

• Show *: The frame number increases on every 
second frame. An asterisk (*) is added to indicate the 
second frame in each frame number pair. (This is the 
display format used by Sony VTRs.) (Example of 
frame number display for 60p clips: 00 t 00* t 
01 t ... t 29 t 29* t 00 t ...)

When no more clips can be previewed: Specifies what to 
do when the number of clips in Preview windows 
(simultaneously open windows or tabs) exceeds the 
number that can be previewed at one time.
• Show a warning before replacing the clip that is 

being edited.
• Replacing the clip that was viewed first. (Do not 

show a warning)

Play tab

Resolution: Specifies the preview playback resolution.
• Auto: Decodes the playback video at a resolution 

which is automatically adjusted to match the screen 
size.

• Normal: Decodes the playback video at the original 
resolution of the clip, regardless of the screen size.

• 1/2, 1/4: Decodes the playback video at half or 
quarter resolution. The image quality is lower, but 
response is better because of the lower demands 
placed on the decoder.

• Replace the clip that was viewed first.
MXF Play mode: Specifies the playback mode of MXF 

clips from among the following.
• MPEG HD: Plays the clips at high resolution (plays 

MXF clips as is).
• Proxy: Plays the clips at low resolution (plays the 

proxy AV data).

For notes on the playback mode of MXF clips, see 
page 80.

Aspect Ratio: Selects the aspect ratios of the index and 
preview pictures of SD clips (DV-AVI format clips). 
Select from the following.
• Auto: Selects 16:9 or 4:3 automatically, according to 

the aspect ratio of the clip.
• 16:9
• 4:3

Note
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Conversion tab

Country: Specifies the video system adopted in the region 
where the application is used.
• NTSC (Include 24p)
• PAL

MP4 to MXF conversion by copy: Specifies the 
recording format to be used at the time of file format 
conversion from MP4 to MXF by a copy operation.
• Bit Rate

For files in the 4:2:0 color format, specifies the bit 
rate of the converted file when file format 
conversion is performed by a copy operation. Select 
from the following. (The bit rate for clips in the 4:2:2 
format is fixed at 50Mbps.)
- 18Mbps
- 25Mbps
- 35Mbps

• Format settings for empty destination folders
Specifies the recording format (frame rate and 
format) to be used when no clip exists at the copy 
destination during file format conversion by copy 
operation. The following combinations of the values 
can be set.

For details about file format conversion by copy 
operation, see page 73.

Output OPAtom files to: Specifies the output folder for 
OPAtom files for the [Avid AAF] subcommand of the 
Export command (see next item “To set the media 
folder in Avid editing systems”). Enter a path 
beginning with a drive name in the edit box. Or click 
the [...] button to open a browse dialog where you can 
select a folder, and then click the [OK] button. 

To set the media folder in Avid editing systems
For Avid Media Composer (V2.5.3 or later), proceed as 
follows.

1 Select [Media Creation] from the [Settings] menu.

The Media Creation dialog opens.

2 Specify Macintosh HD as the Video Drive/Audio 
Drive (media storage drive) in the Import tab.

3 Import an MXF file into Avid Media Composer.

An “Avid Media Files/MXF/1” folder is created in the 
drive specified in step 2.
Specify this folder in the [Output OPAtom files to] 
box.

Flash Band tab

Country Frame 
Rate

Format

NTSC (Include 
24p)

60i/60p/
30p

4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×720)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×720)

4:2:0 35Mbps (×1080)

4:2:2 50Mbps

24p 4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×1080)

PAL 50i/50p/
25p

4:2:0 18Mbps (×1080)

4:2:0 25Mbps (×720)

4:2:0 25Mbps (×1080)

4:2:0 35Mbps (×720)

4:2:0 35Mbps (×1080)

4:2:2 50Mbps

Country Frame 
Rate

Format
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Where to save the corrected clips: Specifies the 
destination folder where this software will save 
duplicate clips created by the flash band correction 
function (see page 82).

• The same location as the original

• Specify the location: Enter a path beginning with a 
drive name in the edit box. Or click the [...] button to 
open a browse dialog where you can select a folder, 
and then click the [OK] button.

Menu list

This section lists the menus of this application.
In the Keyboard shortcut field, the notation “Command + 
N” means that the N key is pressed while holding down the 
Command key.

Menu Command Subcommand Keyboard shortcut Function Reference 
page

XDCAM 
EX Clip 
Browser

About XDCAM 
EX Clip Browser

– – Displays the version of this 
application.

–

About 
MainConcept 
Conversion 
Packs

– – Displays the version of the 
MainConcept plug-in software.

–

Preferences... – Command + , Opens the Preferences dialog. Page 90

Services Mac OS 
Commands

– Execute various commands provided 
by the Mac OS.

–

Hide XDCAM EX 
Clip Browser

– Command + H Hides this application. –

Hide Others – Option + Command + H Hides other applications. –

Show All – – Shows all applications. –

Quit XDCAM EX 
Clip Browser

– Command + Q Quits this application. Page 60

File New Explorer 
Window

– – Opens a new Explorer window. Page 61

New Preview 
Window

– – Opens a new Preview window.

New Tab – Command + T Adds a new tab in the active window. –

Folder New Folder Shift + Command + N Creates a new folder in the currently 
selected media or folder.

Page 85

Rename Option + Command + R Renames the selected folder. Page 85

Close Window – Command + W Closes the active window. –

Close Tab – – Closes the active tab. –

Show in Finder... – Command + N Opens the selected folder in Finder, 
so that you can back up the folder 
contents.

Page 86

Import... – – Imports an MP4 file to the selected 
folder.

Page 77
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File Export MXF for NLEs... – Converts the selected clip to MXF 
format, for use on non-linear editors.

Page 77

MXF for XDCAM 
HD...

– Converts the selected clip to XDCAM 
HD format.

MXF for XDCAM 
HD422...

– Converts the selected clip to XDCAM 
HD422 format.

MXF for XDCAM 
MPEG IMX...

Converts the selected clip to XDCAM 
MPEG IMX format.

MXF for XDCAM 
DVCAM...

Converts the selected clip to XDCAM 
DVCAM format.

Raw DV... – Converts the selected clip to RAW 
DV format.

AVI DV... – Converts the selected clip to AVI DV 
format.

Avid AAF... – Converts the selected clip to Avid 
AAF format.

Windows Media 
File...

– Converts the selected clip to 
Windows Media file format.

Sony PSP 
(H.264/AVC)...

– Converts the selected clip to a format 
for viewing on the PlayStation 
Portable (PSP) game console.

Apple iPod 
(H.264/AVC)...

– Converts the selected clip to a format 
for viewing on the Apple iPod.

Video Hosting 
Service...

– Converts the selected clip to a format 
for uploading to video hosting 
service.

Capture Still 
Image...

– – Creates a bitmap still picture from 
the frame at the current position.

Page 81

Output... – – Opens the Output dialog. Page 66

New clip using 
In/Out section

– – Creates a new clip from the section 
between In and Out points of the 
selected clip.

Page 76

Flash Band Detect In/Out 
section

– Detects frames where flash banding 
has occurred over the range from the 
In point to the Out point of the 
selected clip.

Page 82

All 
Range

– Detects frames where flash banding 
has occurred over the entire range of 
the selected clip.

Correct In/Out 
section

– Corrects frames where flash banding 
has occurred over the range from the 
In point to the Out point of the 
selected clip.

All 
Range

– Corrects frames where flash banding 
has occurred over the range from the 
entire range of the selected clip.

Detect 
and 
Correct

In/Out 
section

– Detects frames where flash banding 
has occurred over the range from the 
In point to the Out point of the 
selected clip, and then corrects those 
frames.

All 
Range

– Detects frames where flash banding 
has occurred over the entire range of 
the selected clip, and then corrects 
those frames.

Eject Media – – Ejects the media, or puts it into a 
state in which it can be safely 
removed.

–

Menu Command Subcommand Keyboard shortcut Function Reference 
page
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Edit Cut – Command + X Cuts the selected clip. Page 74

Copy – Command + C Copies the selected clip. Page 72

Paste – Command + V Pastes a clip that has been cut or 
copied.

Page 72
Page 74

Delete – Command + Delete Deletes the selected clip or folder. Page 75
Page 86

Copy All – Option + Command + C Copies all of the clips in the selected 
media or folder.

Page 74

Select All – Command + A Selects all of the clips in the selected 
media or folder.

–

Batch Edit Clip 
Properties...

– – Opens the Batch Edit Clip Properties 
dialog.

Page 71

Split Folder... – Shift + Command + W Splits the selected folder into folders 
of the specified size.

Page 86

Combine 
Folders...

– Shift + Command + J Combines the selected folder to 
another specified folder.

Page 87

Find Find... Command + F Opens the Find dialog. Page 81

Start – Starts the search.

Stop – Stops the search.

Go to Explorer – Opens the selected clip in an 
Explorer window.

Edit Disc 
Metadata...

– – Opens the Edit Disc Metadata 
dialog.

Page 88

Special 
Characters...

– – Open the Character Palette so that 
you can enter special characters and 
symbols.

–

Menu Command Subcommand Keyboard shortcut Function Reference 
page
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View Show/Hide 
Toolbar

– Option + Command + T Shows or hides the tool buttons. Page 63

Show/Hide 
Folder Tree

– – Shows or hides the Tree View pane. Page 63

Show/Hide 
Component 
View

– – Shows or hides the Component 
View.

Page 64

Up – Command + R Moves up one level in the folder 
hierarchy.

–

Thumbnails – – Puts the List View pane into 
thumbnail view mode.

Page 64

Details – – Puts the List View pane into details 
view mode.

Sort By Clip Name – Sorts the clip list on the selected key, 
in ascending or descending order.Size –

Duration –

Status –

Creation Date –

Last Update –

Rec Mode –

Media Spanning –

Folder Path –

Save sort order – Saves the current sort order for the 
current folder.

–

Filter By Show All – Filter the display to show XDCAM EX 
clips in a specified file format.

–

MP4 –

DV-AVI –

Customize 
Columns...

– – Opens the Customize Columns 
dialog.

Page 66

Customize 
Tooltip...

– – Opens the Customize Tooltip dialog. Page 66

Message 
Options

Reset to the 
Default

– Subsequently displays the message 
box which was set to be hidden by 
the setting of the [Do not show this 
message in the future.] check box.

–

Refresh – – Refreshes the information displayed 
in the active tab of the Explorer 
window.

–

Full Screen – Option + Return Puts the Viewer into Full Screen 
mode.

Page 68

Menu Command Subcommand Keyboard shortcut Function Reference 
page
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Preview Play – L or Space Plays the selected clip. Page 80

Stop – K or Space Stops clip play.

Play Reverse – J Plays the selected clip in the reverse 
direction.

Play In to Out – Shift + Space Plays the range from the In point to 
the Out point of the selected clip.

–1 Frame – T Steps one frame back.

+1 Frame – t Steps one frame forward.

Jump to Start – Home Jumps to the clip start point (first 
frame).

Jump to End – End Jumps to the clip end point (last 
frame).

Jump to In Point – R Jumps to the In point.

Jump to Out 
Point

– r Jumps to the Out point

Previous 
Essence Mark

– Shift + T Jumps to the previous essence 
mark.

Next Essence 
Mark

– Shift + t Jumps to the next essence mark.

Edit Set Index 
Picture

P Sets the frame at the current position 
as the index picture.

Page 80

Mark In I Sets an In point at the current 
position.

Page 76

Mark Out O Sets an Out point at the current 
position.

Clear Mark In Shift + I Clears the In point.

Clear Mark Out Shift + O Clears the Out point.

Clear Mark In/
Out

Shift + X Clears the In and Out points.

Add Essence 
Mark

E Sets an essence mark at the current 
position (up to 126).

–

Delete Essence 
Mark

Shift + E Deletes the essence mark at the 
current position.

–

Set Audio 
Channels...

– – Opens the Set Audio Channels 
dialog.

Page 80

Window Previous Tab – Shift + Command + { Selects the previous tab. Page 62

Next Tab – Shift + Command + } Selects the next tab.

Minimize – Command + M Minimizes the active window. –

Zoom – – Maximizes the active window or 
returns it to its original size.

–

Bring All to Front – – Brings all the currently open windows 
to the front of the screen.

–

Menu Command Subcommand Keyboard shortcut Function Reference 
page
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Error and warning message list

Messages What to do

Failed to initialize OLE. Please confirm whether the OLE 
library version is correct.

There may be a problem with the installation of this application. Try 
installing it again.

Failed to read libraries for Export.

The folder contains some incomplete clips. Please copy all 
files in the [BPAV] folder under the selected folder to an 
SxS card and execute salvage operation on the recording 
equipment.

Data on the media is incomplete, probably because the XDCAM 
EX device was powered off during recording, or because the media 
was ejected prematurely. Return the media to the XDCAM EX 
device and salvage it immediately. The data may become 
unrecoverable if you continue to operate without salvaging it.Incomplete clip exists. Please execute salvage operation 

on the recording equipment.

Reason: The clip database is incorrect. The XDCAM EX format may be corrupt. Try to salvage the material, 
for example by importing an MP4 file to another folder.

Reason: The clip database created by other application. The selected clip database (registration folder) was not created by 
this application. Use the application that created the database to 
edit the clips and perform other clip operations.

Reason: The media may be incorrect or corrupted. The selected clip is in an unsupported format, or there is an error in 
the material data. Check the clip properties.

The clip cannot be displayed in Explorer. Check the properties of the selected clip. It cannot be imported or 
displayed in the list because the format is not compatible with the 
XDCAM EX format.

Failed to save sort order. Try restarting this application, or restarting the computer. If the 
problem persists, install the application again.

The copy destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

The drive specification is invalid, or no media is loaded in the drive. 
Specify an available drive, or load media into the drive.

The move destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

The import destination drive you specified doesn’t exist or 
isn’t ready. Please specify an available drive.

Failed to output.
Reason: The output destination drive you specified 
doesn’t exist or isn’t ready.

The clip database is incorrect, so it cannot be copied. The XDCAM EX format may be corrupt. Try to salvage the material, 
for example by importing an MP4 file to another folder.The clip database is incorrect, so it cannot be moved.

Failed to update properties.

A file exceeding 4 GB needs to be split, so the file cannot 
be copied.

Files larger than 4 GB cannot be managed on media like the SxS 
memory cards used by XDCAM EX devices. Use editing software 
or some other tool to split the file into files smaller than 4 GB and 
then try again.A file exceeding 4 GB needs to be split, so the file cannot 

be moved.

Because AVI clip is included, the clip cannot be created. This function does not support DV-AVI clips. Delete DV-AVI clips 
from the clip specification and try again.Because AVI clip is included, it cannot be copied 

converting to MXF.

Failed to create a clip. The operation was cancelled for one of the following reasons.
• You do not have delete and write privileges to the selected media 

or folder, or these operations are inhibited.
• The data is in an incompatible format, or it is corrupt.
Check the properties of the media or folder.

Reason: Unmatched frame rate. The selected clip cannot be copied due to difference in frame rate 
between that clip and clips existing in the copy destination folder. 
Check the frame rate (NTSC/24p/PAL) of the clip you want to copy 
and then perform copy by selecting a destination folder in which all 
the existing clips are of the same frame rate as the selected clip.
Appendix
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Reason: The video format is different. The selected clip cannot be copied due to difference in resolution 
between that clip and clips existing in the copy destination folder. 
Check the resolution of the clip that you want to copy and then 
perform copy by selecting a destination folder in which all the 
existing clips are of the same resolution as the selected clip.

Reason: Default format hasn’t been set. Please check 
Conversion tab in Preferences.

Set the frame rate and bit rate in the [Rates to apply when rec 
format is unknown] section of the Conversion tab in the 
Preferences dialog.

Reason: Bit Rate hasn’t been set. Please check 
Conversion tab in Preferences.

Make settings in the [MP4 to MXF conversion bit rate] section of 
the Conversion tab in the Preferences dialog.

MainConcept Conversion Pack is the trial version, so the 
conversion output may contain a watermark. For output 
without the watermark, please purchase the full version 
MainConcept Conversion Pack.

Purchase the full version plug-in software (MainConcept 
Conversion Pack #1 or #2) at the MainConcept website, and install 
it on your system. You can access the MainConcept website by 
selecting [About MainConcept Conversion Packs] from the 
[XDCAM EX Clip Browser] menu, and then clicking the URL in the 
dialog that appears.

Reason: Failed to convert. Check the recording format of the clip that you want to copy and 
that of the clips existing in the copy destination folder. File 
conversion may be disabled depending on the recording format of 
the original clip and the clips in the copy destination folder.

Reason: The clip is less than 2 seconds, so it cannot be 
written.

XDCAM devices do not support writing of clips shorter than two 
seconds.

It cannot be copied because a Clip less than 2 seconds is 
included.

UserData folder cannot be specified as the destination to 
copy MXF files. Please change the Copy All destination in 
Preferences.

Change the setting in [Copy all files to:] of the General tab in the 
Preferences dialog.

Failed to import the clip. Check the properties of the clip. You may not have access 
privileges to the clip, or the clip may be an MP4 file that is not 
compatible with the XDCAM EX format.

UserData folder cannot be specified as the output 
destination.

Change the output destination.

UserData folder cannot be specified as the destination to 
output OPAtom files. Please change the OPAtom file 
output destination in Preferences.

Change the setting in [Output OPAtom files to:] of the Conversion 
tab in the Preferences dialog.

The name is already used. Please specify another name. Specify another name or change the output destination.

xxxx already exists in the output folder. Please specify 
another name.

The file name is invalid or too long. The save destination may not be recognized if the full path to the 
save destination is too long. Change to a save destination with a 
shorter path name.

The list includes a clip that has 127 or more Essence 
Marks, so it cannot be output.

The output target list includes a clip with 127 or more essence 
marks. (The maximum number of essence marks that can be 
handled by this software is 126 per clip.) Delete the clip from the 
output target list. To include the clip in the output target list, delete 
unneeded essence marks to bring the total to 126 or fewer.

Error occurred during the export. Please refer to the 
details from the context on each clip.

Open the export dialog to check the report which is displayed when 
[Error detail] is selected from the context menu of the clip with the 
error.

Reason: An error occurred during conversion. The conversion failed for one of the following reasons.
• You do not have delete and write privileges to the output folder, 

or these operations are inhibited.
• The selected clip is in an unsupported format, or the material 

data is corrupt.
Check the properties of the folder and clip.

Reason: Unsupported XDCAM. The selected XDCAM drive is not supported.

Reason: Unsupported codec. The codec of the selected clip on the XDCAM drive is not 
supported.

Messages What to do
99Appendix



100

  F
or M

ac O
S

How to obtain the plug-in software

The optional MainConcept plug-in software can be 
purchased and downloaded from the following website. 
You can access this website by selecting [About 
MainConcept Conversion Packs] from the [XDCAM EX 
Clip Browser] menu, and then clicking the URL in the 
dialog that appears.
http://www.mainconcept.com/plugin4clipbrowser

Licenses

MPEG-4 Visual Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 
VISUAL PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NONCOMMERCIAL USE OF A 
CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE WITH THE 
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”)

AND/OR
(ii)DECODING MPEG-4 VIDEO THAT WAS 

ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY 
AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED BY MPEG LA TO PROVIDE 
MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE.
ADDITIONAL INFORMATION INCLUDING THAT 
RELATING TO PROMOTIONAL, INTERNAL AND 
COMMERCIAL USES AND LICENSING MAY BE 
OBTAINED FROM MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/sales 
of any storage media storing MPEG-4 Visual video 

Failed to create a folder. Check the properties of the selected media or folder. You may not 
have delete and write privileges to the media or folder, or these 
operations may be inhibited.

You cannot use [XXX] as a folder name. Please specify 
another name.

Specify a name other than “BPAV”.

It contains a string reserved by the system, so it cannot be 
set.

The name contains characters reserved by the operating system. 
Enter a name that does not contain these characters.

Reason: The clip file name has already been reserved. Change the file name or copy destination.

A name beginning with a dot (.) is used by the system only. 
Please give another name for User Disc ID.

Specify another name.

Failed to change the folder name. Check the properties of the selected folder. You may not have 
delete and write privileges to the folder, or these operations may be 
inhibited.Failed to delete the folder.

Failed to split the folder.

Failed to combine the folders. Check the properties of the combine source or destination folder. 
You may not have delete and write privileges to these folders, or 
these operations may be inhibited.

[XXX] contains a work folder, so it cannot be deleted. The selected media or folder contains one or more folders that are 
not under the management of this application. Delete or move 
these folders and then try again.Reason: [XXX] has a sub folder.

The folder [XXX] cannot be split. Reason: The folder 
contains a file exceeding the specified split unit of [XXX 
GB]. Clip name: 

The folder cannot be split into folders of the specified size because 
at least one file larger than that size exists. Specify a split size that 
is larger than the size of the largest file.

Failed to save disc metadata. Check the properties of the selected XDCAM drive and the state of 
the write protect tab on the disc. You may not have delete and write 
privileges for the selected XDCAM drive, or these operations may 
be inhibited.

The management information will be updated. If the media 
is write protected, please unlock the write protection 
before proceeding this operation.

If the selected media or folder is access protected or write 
protected, unlock and try again.

Reason: The number of audio samples is not enough. The audio after conversion may contain noise, because the number 
of audio samples is lower than the specified number. Check the 
number of audio samples in the conversion source clip.

Failed to eject xxxx. The media is in use. Please make 
sure that the file is not being accessed.

If a media clip is being accessed, stop the access.

Messages What to do
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information (ii) distribution/broadcasting of MPEG-4 
Visual video information in any manner (such as online 
video distribution service, internet broadcasting, TV 
broadcasting). Other usage of this product may be required 
to obtain license from MPEGLA. Please contact MPEG 
LA for any further information. MPEG LA, L.L.C., 250 
STEELE STREET, SUITE 300, DENVER, COLORADO 
80206, http://www.mpegla.com

MPEG-2 Video Patent Portfolio License
ANY USE OF THIS PRODUCT OTHER THAN 
CONSUMER PERSONAL USE IN ANY MANNER 
THAT COMPLIES WITH THE MPEG-2 STANDARD 
FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED 
WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG LA, 
L.L.C., 250 STEELE STREET, SUITE 300, DENVER, 
COLORADO 80206.

AVC Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A 
CONSUMER TO
(i) ENCODE VIDEO IN COMPLIANCE WITH THE 

AVC STANDARD (“AVC VIDEO”)
AND/OR
(ii)DECODE AVC VIDEO THAT WAS ENCODED BY 

A CONSUMER ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL 
INFORMATION MAY BE OBTAINED FROM MPEG 
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM

VC-1 Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE VC-1 
PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A 
CONSUMER TO
(i) ENCODE VIDEO IN COMPLIANCE WITH THE VC-

1 STANDARD (“VC-1 VIDEO”)
AND/OR
(ii)DECODE VC-1 VIDEO THAT WAS ENCODED BY 

A CONSUMER ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE VC-1 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL 

INFORMATION MAY BE OBTAINED FROM MPEG 
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM
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